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About This Book

AWARNING! Text set off in this manner indicates that failure to follow directions could result in bodily
harm or loss of life.

ACAUTION: Text set off in this manner indicates that failure to follow directions could result in
damage to equipment or loss of information.

@NOTE: Text set off in this manner provides important supplemental information.
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1 Product Features

Overview
Figure 1-1 HP Compaq Pro 4300 All-in-One Business PC

The HP Compaq Pro 4300 All-in-One Business PC offers the following features:

Integrated All-in-One form factor
20-inch diagonal widescreen 1600 x 900 WLED anti-glare display
Adjustable tilt

Removable panels on the back of the chassis allow users or technicians to easily and efficiently
service the PC

Optional integrated 1.3 MP webcam & single non-array microphone

Integrated stereo speakers

Overview
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e  Choice of wired or wireless keyboard and mouse

e  Windows® 7 or Windows 8 operating system

e  6-in-1 media card reader

e 6 USB2.0ports

e  Tray-load HP SuperMulti DVD+/-RW SATA Drive

e Upto1TB hard drive

e  2nd and 3rd generation Intel® Core™ processors

e Intel H61 Express Chipset

e Integrated Intel HD Graphics

e Integrated Gigabit network connection (Realtek RTL 8111 F Gigabit Ethernet)
e Upto 16 GB of DDR3 SDRAM memory

e  Optional wireless LAN (802.11 a/g/n, 802.11 a/g/n with Bluetooth®)

e Face Recognition for HP ProtectTools software with auto-login capabilities (only with the optional
webcam)

e ENERGY STAR® qualified, EPEAT® Silver registered, and offers 89-percent energy-efficient
power

2 Chapter 1 Product Features



Front Components

Figure 1-2 Front Components

0

Table 1-1 Front Components

Component Component
1 Webcam 4 Power button and LED
2 Single microphone 5 High-performance stereo speakers

3 20-inch diagonal 16:9 widescreen LED-backlit LCD
display

Front Components 3



Side Components

Figure 1-3 Side Components

Table 1-2 Side Components

Component Component

1 HP USB Media Card Reader 6 Optical disc drive activity LED
2 (2) USB 2.0 ports 7 Tray-load optical disc drive

3 Microphone jack 8 Brightness increase button

4 Headphone jack 9 Brightness decrease button

5 Optical disc drive eject button 10 Hard drive activity LED

4 Chapter 1 Product Features



Rear Components

Figure 1-4 Rear Components

Table 1-3 Rear Components

Component

Component

1

Drive access panel

7

Security lock slot

2 Center access panel 8 Power connector with LED indicator
3 Memory access panel 9 RJ-45 Gigabit Ethernet port

4 Optical disc drive location 10 Stereo audio line out

5 Hard drive location 11 (4) USB 2.0 ports

6 Memory and battery location 12 Serial port

Rear Components

5



Adjusting Tilt

Tilt the computer forward up to -5 degrees or backward up to +25 degrees to set it to a comfortable
eye level.

Figure 1-5 Adjusting Tilt

6 Chapter 1 Product Features



2 Activating and Customizing the
Software

E/?NOTE: This chapter provides information for both Windows 7 and Windows 8.

Activating and customizing the software in Windows 7

If your computer was not shipped with a Windows® operating system, some portions of this
documentation do not apply. Additional information is available in online help after you activate the
operating system.

/\ CAUTION: Do not add optional hardware or third-party devices to the computer until the operating
system is successfully activated. Doing so may cause errors and prevent the operating system from
installing properly.

E‘%NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor
to permit the required airflow.

Activating the Windows operating system

The first time you turn on the computer, the operating system is set up and activated automatically.
This process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to
complete the activation.

We recommend that you register your computer with HP during operating system setup so you can
receive important software updates, facilitate support questions, and sign up for special offers.

/\ CAUTION: After the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL
THE PROCESS IS COMPLETE. Turning off the computer during the activation process may damage
the software that runs the computer or prevent its proper installation.

¢ NOTE: If the computer shipped with more than one operating system language on the hard drive,
the activation process could take up to 60 minutes.

Activating and customizing the software in Windows 7
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8

Downloading Windows 7 updates

Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.

1. To set up your Internet connection, click Start > Internet Explorer and follow the instructions on
the screen.

2. After an Internet connection has been established, click the Start > All Programs > Windows
Update.

3.  Run Windows Update monthly thereafter.

Installing or upgrading device drivers

When installing optional hardware devices after the operating system installation is complete, you
must also install the drivers for each of the devices.

In Windows 7, if prompted for the i386 directory, replace the path specification with C:\1386, or use
the Browse button in the dialog box to locate the i386 folder. This action points the operating system
to the appropriate drivers.

Obtain the latest support software, including support software for the operating system, from
http://www.hp.com/support. Select your country and language, select Download drivers and
software (and firmware), enter the model number of the computer, and press Enter.

Customizing the monitor display

If you wish, you can select or change the monitor refresh rates, screen resolution, color settings, font
sizes, and power management settings.

For more information, refer to the online documentation provided with the graphics controller utility or
the documentation that came with your monitor.

Right-click on the Windows desktop, then click Personalize to change display settings.

Activating and customizing the software in Windows 8

Additional information is available in online help after you activate the operating system.

~?NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor

to permit the required airflow.

Activating the Windows Operating System

The first time you turn on the computer, the operating system is set up and activated automatically.
This process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to
complete the activation.

We recommend that you register your computer with HP during operating system set up so you can
receive important software updates, facilitate support questions, and sign up for special offers. You
can also register your computer with HP using the Register with HP app on the Start screen.

Chapter 2 Activating and Customizing the Software
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CAUTION: After the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL
THE PROCESS IS COMPLETE. Turning off the computer during the activation process may damage
the software that runs the computer or prevent its proper installation.

Downloading Windows 8 updates

Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.

Run Windows Update as soon as possible after you set up your computer.
1. Point to the upper-right or lower-right corner of the Start screen to display the charms.
2. Click Settings > Change PC Settings > Windows Update.

3. Run Windows Update monthly thereafter.

Customizing the monitor display
You can customize display settings for Windows 8 separately for the Start screen and the Desktop.
To customize the Start screen:
1. Point to the upper-right or lower-right corner of the Start screen to display the charms.
2. Click Settings > Change PC Settings.
3. Click Personalize to change the display settings.
To customize the Desktop:
1. Click the Desktop app on the Start screen.

2. Right-click on the desktop, and then click Personalize to change display settings.

Activating and customizing the software in Windows 8 9



3 Computer Setup (F10) Utility

Computer Setup (F10) Utilities

Use Computer Setup (F10) Utility to do the following:

Change factory default settings.
Set the system date and time.

Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash
media devices.

Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run
during a Full Boot. You can set the system to:

U always Quick Boot (default);
Q periodically Full Boot (from every 1 to 30 days); or
O always Full Boot.

Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as
memory count, product name, and other non-error text messages. If a POST error occurs, the
error is displayed regardless of the mode selected. To manually switch to Post Messages
Enabled during POST, press any key (except F1 through F12).

Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

Enter the Asset Tag or property identification number assigned by the company to this computer.

Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

Establish a setup password that controls access to the Computer Setup (F10) Utility and the
settings described in this section.

Secure integrated 1/O functionality, including the serial, USB, or parallel ports, audio, or
embedded NIC, so that they cannot be used until they are unsecured.

Enable or disable removable media boot ability.

10 Chapter 3 Computer Setup (F10) Utility



Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).

Replicate the system setup by saving system configuration information on a USB device and
restoring it on one or more computers.

Execute self-tests on a specified ATA hard drive (when supported by drive).

Enable or disable DriveLock security (when supported by drive).

Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system.
To access the Computer Setup Utilities menu, complete the following steps:

1.
2.

Turn on or restart the computer.
Repeatedly press F10 when the monitor light turns green to access the utility.

You can also press Esc to a menu that allows you to access different options available at
startup, including the Computer Setup utility.

=7 NOTE: If you do not press F10 at the appropriate time, you must restart the computer and

again repeatedly press F10 when the monitor light turns green to access the utility.

A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and
down) keys to select the option you want, then press Enter. To return to the Computer Setup
Utilities menu, press Esc.

To apply and save changes, select File > Save Changes and Exit.
e If you have made changes that you do not want applied, select Ignore Changes and Exit.

e To reset to factory settings or previously saved default settings (some models), select
Apply Defaults and Exit. This option will restore the original factory system defaults.

@NOTE: Not all settings shown in the following sections are available for all models

/\ CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup
(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only
after exiting the F10 Setup screen.

Table 3-1 Computer Setup (F10) Utility

Heading Table

File Computer Setup—File on page 12
Storage Computer Setup—Storage on page 13
Security Computer Setup—Security on page 16
Power Computer Setup—Power on page 20
Advanced Computer Setup—Advanced on page 21

Computer Setup (F10) Utilities 11



Computer Setup—File

configuration.

=?NOTE: Support for specific Computer Setup options may vary depending on the hardware

Table 3-2 Computer Setup—File

Option

Description

System Information

Lists:

e  Product name

e  SKU number

e  Processor type/speed/stepping

e  Cache size (L1/L2/L3) (dual core processors have this listed twice)
e Installed memory size/speed, number of channels (single or dual) (if applicable)
e Integrated MAC address for embedded, enabled NIC (if applicable)
e  System BIOS (includes family name and version)

e  Chassis serial number

e  Asset tracking number

e  ME firmware version

e  ME Management mode

About

Displays copyright notice.

Set Time and Date

Allows you to set system time and date.

Flash System ROM

Allows you to update the system ROM with a BIOS image file located on removable media.

Replicated Setup

Save to Removable Media
Saves system configuration to a formatted USB flash media device.
Restore from Removable Media

Restores system configuration from a USB flash media device.

Default Setup

Save Current Settings as Default
Saves the current system configuration settings as the default.
Restore Factory Settings as Default

Restores the factory system configuration settings as the default.

Apply Defaults and
Exit

Applies the currently selected default settings and clears any established passwords.

Ignore Changes
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and
Exit

Saves changes to system configuration or default settings and exits Computer Setup.

12 Chapter 3 Computer Setup (F10) Utility



Computer Setup—Storage

E%?NOTE: Support for specific Computer Setup options may vary depending on the hardware

configuration.

Table 3-3 Computer Setup—Storage

Option

Description

Device Configuration

Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options
may be presented:

Hard Disk: Size, model, firmware version, serial number, connector color.
Translation mode (ATA disks only)

Lets you select the translation mode to be used for the device. This enables the BIOS to
access disks partitioned and formatted on other systems and may be necessary for users of
older versions of UNIX (e.g., SCO UNIX version 3.2). Options are Automatic, Bit-Shift,

LBA Assisted, User, and Off.

Available only when the drive translation mode is set to User, allows you to specify the
parameters (logical cylinders, heads, and sectors per track) used by the BIOS to translate
disk 1/0 requests (from the operating system or an application) into terms the hard drive can
accept. Logical cylinders may not exceed 1024. The number of heads may not exceed 256.
The number of sectors per track may not exceed 63.

CAUTION: Ordinarily, the translation mode selected automatically by the BIOS should not
be changed. If the selected translation mode is not compatible with the translation mode that
was active when the disk was partitioned and formatted, the data on the disk will be
inaccessible.

CD-ROM: Model, firmware version, serial number, connector color (not included for USB CD-
ROM).

SSD Life Used
NOTE: Displays for solid-state drives.
SMART (ATA disks only)

Diskette: Model and firmware version.

NOTE: Displays for USB diskette drives.

Default Values (ATA disks only)
See Translation Mode above for details.

SATA Defaults

Computer Setup (F10) Utilities
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Table 3-3 Computer Setup—Storage (continued)

Storage Options eSATA Port
Allows you to set a SATA port as an eSATA port for use with an external drive. Default is enabled.

This setting affects only the port with the black connector, labeled as eSATA on the system board.
This port should have the eSATA back panel connector attached to use eSATA drives. For more
information, see the eSATA white paper at www.hp.com.

SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating
system. There are three supported options: IDE, RAID, and AHCI (default).

CAUTION: SATA emulation changes may prevent access to existing hard drive data and
degrade or corrupt established volumes.

IDE - This is the most backwards-compatible setting of the three options. Operating systems
usually do not require additional driver support in IDE mode.

RAID - Allows DOS and boot access to RAID volumes. Use this mode with the RAID device driver
loaded in the operating system to take advantage of RAID features.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take
advantage of more advanced features of the SATA controller.

NOTE: The RAID/AHCI device driver must be installed prior to attempting to boot from a RAID/
AHCI volume. If you attempt to boot from a RAID/AHCI volume without the required device driver
installed, the system will crash (blue screen). RAID volumes may become corrupted if they are
booted to after disabling RAID.

Removable Media Boot
Enables/disables ability to boot the system from removable media. Default is enabled.
Max eSATA Speed

Allows you to choose 1.5 Gbps or 3.0 Gpbs as the maximum eSATA speed. By default, the speed
is limited to 1.5 Gbps for maximum reliability.

CAUTION: Consult your eSATA drive and cable manufacturer before enabling 3.0 Gpbs speed.
Some drive and cable combinations may not run reliably at 3.0 Gpbs.

14 Chapter 3 Computer Setup (F10) Utility



Table 3-3 Computer Setup—Storage (continued)

DPS Self-Test Allows you to execute self-tests on ATA hard drives capable of performing the Drive Protection
System (DPS) self-tests.
NOTE: This selection will only appear when at least one drive capable of performing the DPS
self-tests is attached to the system.

Boot Order Allows you to:

e EFI Boot Sources: Specify the order in which EFI boot sources (such as a internal hard
drive, USB hard drive, USB optical drive, or internal optical drive) are checked for a bootable
operating system image. Each device on the list may be individually excluded from or
included for consideration as a bootable operating system source.

EFI boot sources always have precedence over legacy boot sources.

e Legacy Boot Sources: Specify the order in which legacy boot sources (such as a network
interface card, internal hard drive, USB optical drive, or internal optical drive) are checked for
a bootable operating system image. Each device on the list may be individually excluded
from or included for consideration as a bootable operating system source.

Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: To drag a device to a preferred place, press Enter. To remove the device from
consideration as a bootable device, press F5.

You can use F5 to disable individual boot items, as well as disable EFI boot and/or legacy boot.

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating
system has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press Esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping
the boot menu) when the monitor light turns green. After POST is completed, a list of bootable
devices is displayed. Use the arrow keys to select the preferred bootable device and press Enter.
The computer then boots from the selected non-default device for this one time.

Computer Setup (F10) Utilities
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Computer Setup—Security

=?NOTE: Support for specific Computer Setup options may vary depending on the hardware

configuration.

Table 3-4 Computer Setup—Security

Option

Description

Setup Password

Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

Power-On Password

Allows you to set and enable a power-on password. The power-on password prompt appears
after a power cycle or reboot. If the user does not enter the correct power-on password, the unit
will not boot.

Password Options

(This selection appears
only if a power-on
password or setup
password is set.)

Allows you to enable/disable:

e  Lock Legacy Resources (determines whether or not Windows Device Manager is allowed to
change resource settings for serial and parallel ports).

e  Setup Browse Mode (appears if a setup password is set) (allows viewing, but not changing,
the F10 Setup Options without entering setup password). Default is enabled.

e  Password prompt on F9 & F12 (requires setup password to use these boot functions).
Default is enabled.

° Network Server Mode. Default is disabled.

Smart Cover

Allows you to:

e  Lock/unlock the Cover Lock.

e  Set the Cover Removal Sensor to Disable/Notify User/Setup Password.

NOTE: Notify User alerts the user that the sensor has detected that the cover has been

removed. Setup Password requires that the setup password be entered to boot the computer if
the sensor detects that the cover has been removed.

Device Security

Allows you to set Device Available/Device Hidden (default is Device Available) for:
e Embedded security device
e  System audio
e  USB controller (varies by model)
e  Network controller
NOTE: You must disable AMT before trying to hide the network controller.
e  Serial port
e  Parallel port

e  SATA ports (varies by model)

USB Security

Allows you to set Enabled/Disabled (default is Enabled) for:
e Front USB Ports
e Rear USB Ports

e  Accessory USB Ports

16 Chapter 3 Computer Setup (F10) Utility



Table 3-4 Computer Setup—Security (continued)

Slot Security

Allows you to disable any PCI or PCI Express slot. Default is enabled.

Network Boot

Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCI
expansion card or embedded on the system board.) Default is enabled.

System IDs

Allows you to set:

e  Asset tag (18-byte identifier), a property identification number assigned by the company to
the computer.

e  Ownership tag (80-byte identifier) displayed during POST.
e  Universal Unique Identifier (UUID) number. The UUID can only be updated if the current
chassis serial number is invalid. (These ID numbers are normally set in the factory and are

used to uniquely identify the system.)

e  Keyboard locale setting for System ID entry.

Master Boot Record
Security

Enables/disables Master Boot Record (MBR) security.

The MBR contains information needed to successfully boot from a disk and to access the data
stored on the disk. Master Boot Record Security may prevent unintentional or malicious changes
to the MBR, such as those caused by some viruses or by the incorrect use of certain disk utilities.
It also allows you to recover the "last known good" MBR, should changes to the MBR be detected
when the system is restarted.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the
current bootable disk while in MS-DOS or Windows Safe Mode.

NOTE: Most operating systems control access to the MBR of the current bootable disk; the
BIOS cannot prevent changes that may occur while the operating system is running.

Restores the backup Master Boot Record to the current bootable disk. Default is disabled.
Only appears if all of the following conditions are true:

e MBR security is enabled

e A backup copy of the MBR has been previously saved

e  The current bootable disk is the same disk from which the backup copy was saved
CAUTION: Restoring a previously saved MBR after a disk utility or operating system has
modified the MBR, may cause the data on the disk to become inaccessible. Only restore a

previously saved MBR if you are confident that the current bootable disk's MBR has been
corrupted or infected with a virus.

Computer Setup (F10) Utilities
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Table 3-4 Computer Setup—Security (continued)

System Security Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches.
(these options are Default is enabled.

hardware dependent)
SVM CPU Virtualization (enable/disable). Controls the virtualization features of the processor.
Changing this setting requires turning the computer off and then back on. Default is disabled.

Virtualization Technology (VTx) (enable/disable) - Controls the virtualization features of the
processor. Changing this setting requires turning the computer off and then back on. Default is
disabled.

Virtualization Technology Directed 1/O (VTd) (enable/disable) - Controls virtualization DMA
remapping features of the chipset. Changing this setting requires turning the computer off and
then back on. Default is disabled.

Trusted Execution Technology (enable/disable) - Controls the underlying processor and chipset
features needed to support a virtual appliance. Changing this setting requires turning the
computer off and then back on. Default is disabled. To enable this feature you must enable the
following features:

e Embedded Security Device Support
e  Virtualization Technology
e  Virtualization Technology Directed 1/0

Embedded Security Device (enable/disable) - Permits activation and deactivation of the
Embedded Security Device.

NOTE: To configure the Embedded Security Device, a Setup password must be set.

e Reset to Factory Settings (Do not reset/Reset) - Resetting to factory defaults will erase all
security keys and leave the device in a disabled state. Changing this setting requires that
you restart the computer. Default is Do not reset.

CAUTION: The embedded security device is a critical component of many security
schemes. Erasing the security keys will prevent access to data protected by the Embedded
Security Device. Choosing Reset to Factory Settings may result in significant data loss.

° Measure boot variables/devices to PCR1 - Typically, the computer measures the boot path
and saves collected metrics to PCR5 (a register in the Embedded Security Device). Bitlocker
tracks changes to any of these metrics, and forces the user to re-authenticate if it detects
any changes. Enabling this feature lets you set Bitlocker to ignore detected changes to boot
path metrics, thereby avoiding re-authentication issues associated with USB keys inserted in
a port. Default is enabled.

System Security OS management of Embedded Security Device (enable/disable) - This option allows the user to
(continued) limit OS control of the Embedded Security Device. Default is enabled. This option is automatically
disabled if Trusted Execution Technology is enabled.

e Reset of Embedded Security Device through OS (enable/disable) - This option allows the
user to limit the operating system ability to request a Reset to Factory Settings of the
Embedded Security Device. Default is disabled.

NOTE: To enable this option, a Setup password must be set.

e  No PPI provisioning (Windows 8 only) - This option lets you set Windows 8 to bypass the PPI
(Physical Presence Interface) requirement and directly enable and take ownership of the
TPM on first boot. You cannot change this setting after TPM is owned/initialized, unless the

TPM is reset. Default is disabled for non-Windows 8 systems, and enabled for Windows 8.

e Allow PPI policy to be changed by OS. Enabling this option allows the operating system to
execute TPM operations without Physical Presence Interface. Default is disabled.

NOTE: To enable this option, a Setup password must be set.
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Table 3-4 Computer Setup—Security (continued)

DriveLock Security

Allows you to assign or modify a master or user password for hard drives. When this feature is
enabled, the user is prompted to provide one of the DriveLock passwords during POST. If neither
is successfully entered, the hard drive will remain inaccessible until one of the passwords is
successfully provided during a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the DriveLock
feature is attached to the system.

Secure Boot
Configuration

This is a feature of Windows 8.

e Legacy Support—Enable/Disable. Allows you to turn off all legacy support on the computer,
including booting to DOS, running legacy graphics cards, booting to legacy devices, and so
on. If set to disable, legacy boot options in Storage > Boot Order are not displayed. Default
is enabled.

e  Secure Boot—Enable/Disable. Allows you to make sure an operating system is legitimate
before booting to it, making Windows resistant to malicious modification from preboot to full
OS booting, preventing firmware attacks. UEFI and Windows Secure Boot only allow code
signed by pre-approved digital certificates to run during the firmware and OS boot process.
Default is disabled, except for Windows 8 systems which have this setting enabled. Secure
Boot enabled also sets Legacy Support to disabled.

e  Key Management—This option lets you manage the custom key settings.

° Clear Secure Boot Keys—Don't Clear/Clear. Allows you to delete any previously loaded
custom boot keys. Default is Don't Clear.

° Key Ownership—HP Keys/Custom Keys. Selecting Custom Mode allows you to modify
the contents of the secure boot signature databases and the platform key (PK) that
verifies kernels during system start up, allowing you to use alternative operating
systems. Selecting HP Keys causes the computer boot using the preloaded HP-specific
boot keys. Default is HP Keys.

e Fast Boot—Enable/Disable. Fast boot disables the ability to interrupt boot, such as pressing f
keys to access items before the operating system loads. Default is disabled.

NOTE: If Windows 8 detects a serious error, it will interrupt the boot process automatically
and display advanced boot options.

From Windows 8, you can press Shift and select Restart to access the screen that lets you
boot to a device or troubleshoot your computer.

Computer Setup (F10) Utilities
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Computer Setup—Power

=?NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-5 Computer Setup—Power

Option Description
OS Power e |dle Power Savings—Extended/Normal. Allows certain operating systems to decrease the
Management processors power consumption when the processor is idle. Default is extended.

e  Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce
processor voltage and frequency when the current software load does not require the full
capabilities of the processor. Default is enabled.

e Unique Sleep State Blink Rates—Enable/Disable. This feature is designed to provide a
visual indication of what sleep state the system is in. Each sleep state has a unique blink
pattern. Default is disabled.

NOTE: For Windows 8 systems with Fast Boot support, a normal shutdown goes to the S4
state, not the S5 state.

° SO0 (On) = Solid green LED.

° S3 (Stand By)= 3 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(green LED) — repeated cycles of 3 blinks and a pause.

° S4 (Hibernation)= 4 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(green LED) — repeated cycles of 4 blinks and a pause.

o S5 (Soft Off) = LED is off.

Hardware Power SATA Power Management — Enables or disables SATA bus and/or device power management.
Management Default is enabled.

S5 Maximum Power Savings — Turns off power to all nonessential hardware when system is off to
meet EUP Lot 6 requirement of less than 0.5 Watt power usage. Default is disabled.

PCI Express x16 Slot 1 — Sets Active State Power Management (ASPM) of the bus. ASPM lets
you set lower power modes that activate when the bus is not being used. Options are Disabled,
LOs, L1, LOs and L1. Default is ASPM Disabled.

PCI Express x1 Slot 1 — Sets Active State Power Management (ASPM) of the bus. ASPM lets you
set lower power modes that activate when the bus is not being used. Options are Disabled, LOs,
L1, LOs and L1. Default is ASPM Disabled.

Network Controller — Sets ASPM of the bus. ASPM lets you set lower power modes that activate
when the bus is not being used. Options are Disabled, LOs, L1, LOs and L1. Default is ASPM
Disabled.

USB 3.0 Controller — Sets ASPM of the bus. ASPM lets you set lower power modes that activate
when the bus is not being used. Options are Disabled, LOs, L1, LOs and L1. Default is ASPM
Disabled.

Thermal Fan idle mode—This bar graph controls the minimum permitted fan speed.

NOTE: This setting only changes the minimum fan speed. The fans are still automatically
controlled.
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Computer Setup—Advanced

E%?NOTE: Support for specific Computer Setup options may vary depending on the hardware

configuration.

Table 3-6 Computer Setup—Advanced (for advanced users)

Option Heading

Power-On Options Allows you to set:

POST mode (QuickBoot, Clear Memory, FullBoot, or FullBoot Every x Days).

° QuickBoot (default) = Do not clear memory or perform a memory test.

° FullBoot = Memory test (count) on cold boot. Clears memory on all boots.

° Clear Memory = No memory count on cold boot. Clears memory on all boots.

° FullBoot Every x Days = Memory count on 1st cold boot on or after the xth day. No
more memory counts until 1st cold boot on or after x days. Clears memory on all boots.

POST messages (enable/disable). Enabling this feature will cause the system to display
POST error messages, which are error messages displayed on the monitor during the Power
On Self Test if the BIOS encounters some kind of problem while starting the PC. A POST
error message will only display on screen if the computer is capable of booting this far. If the
POST detects an error before this point, a beep code is generated instead. Default is
disabled.

Press the ESC key for Startup Menu (Enable/Disable). This feature controls the display of
the text “Press the ESC key for Startup Menu” during POST. This text does not display on
Windows 8 systems with Fast Boot support. Other text also will not display (for example,
Ownership Tag). Default is enabled.

Option ROM Prompt (enable/disable). Enabling this feature will cause the system to display
a message before loading option ROMs. Default is enabled.

After Power Loss (off/on/previous state). Default is Power off. Setting this option to:
° Power off—causes the computer to remain powered off when power is restored.

° Power on—causes the computer to power on automatically as soon as power is
restored.

° Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be
able to use the suspend/sleep feature or the Remote Management features.

POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST
process. This delay is sometimes needed for hard disks on some PCI cards that spin up very
slowly, so slowly that they are not ready to boot by the time POST is finished. The POST
delay also gives you more time to select F10 to enter Computer (F10) Setup. Default is
None.

Remote Wakeup Boot Source (remote server/local hard drive). Default is Local hard drive.

Factory Recovery Boot Support (Enable/Disable). Provides the ability for the BIOS to redirect
the boot to the recovery partition on the user hard drive, if present. Some versions of the
recovery software honor the F11 key press even when this feature is disabled by the BIOS.
Default is disabled.

Bypass F1 Prompt on Configuration Changes (Enable/Disable). Allows you to set the
computer not to confirm when changes were made. Default is disabled.

Computer Setup (F10) Utilities
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Table 3-6 Computer Setup—Advanced (for advanced users) (continued)

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices Allows you to set resources for or disable Legacy devices.

Select the Legacy device's IRQ, DMA, and I/0 Range. The settings may not take effect for all
operating systems. To hide a device from the operating system, see Security > Device Security.

Bus Options Allows you to enable or disable:

PCl SERR# Generation. Default is enabled.

PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration
space; only needed when more than one graphics controller is installed. Default is disabled.

Device Options Allows you to set:

Printer mode (Bi-Directional, EPP + ECP, Output Only). ECP = Enhanced Capabilities Port,
EPP = Enhanced Parallel Port. Default is EPP+ECP.

Num Lock State at Power-On (off/on). Default is off.

Integrated Video (enable/disable). Use this option to disable the integrated video controller
when another video controller is present in the system. Default is enabled.

Integrated Graphics (Auto/Disable/Force) Use this option to manage integrated (UMA)
graphics memory allocation. The value you choose is allocated permanently to graphics and
is unavailable to the operating system. For example, if you set this value to 512M on a
system with 2 GB of RAM, the system always allocates 512 MB for graphics and the other
1.5 GB for use by the BIOS and operating system. Default is Auto which sets memory
allocation to 512 MB.

If you select Force, the UMA Frame Buffer Size option displays, which lets you set the UMA
memory size allocation between 32 MB and 1 GB.

Internal Speaker (does not affect external speakers). Default is enabled.

NIC PXE Option ROM Download (PXE, iSCSI, disabled). The BIOS contains an embedded
NIC option ROM to allow the unit to boot through the network to a PXE server. This is
typically used to download a corporate image to a hard drive. The NIC option ROM takes up
memory space below 1MB commonly referred to as DOS Compatibility Hole (DCH) space.
This space is limited. This F10 option will allow users to disable the downloading of this
embedded NIC option ROM thus giving more DCH space for additional PCI cards which may
need option ROM space. The default will be to have the NIC option-ROM-enabled. Default is
PXE.

SATA RAID Option ROM Download (enable/disable). The BIOS contains an embedded
SATA RAID option ROM for RAID support. This can be temporarily disabled to save DCH
space. Note that with the option ROM disabled, users will be unable to boot to hard drives in
the system while running in RAID mode. Default is disabled.

Multi-Processor (enable/disable). Use this option to disable multi-processor support under
the OS. Default is enabled.

Hyper threading (enable/disable). Use this option to disable processor hyper-threading.
Turbo Mode (enable/disable). Allows you to enable and disable the Intel Turbo Mode feature,

which allows one core of the system to run at a higher than standard frequency and power if
other cores are idle. Default is enabled.
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Table 3-6 Computer Setup—Advanced (for advanced users) (continued)

VGA Configuration Displayed only if there is an add-in video card in the system. Allows you to specify which VGA
controller will be the “boot” or primary VGA controller.

AMT Configuration Allows you to set:

e  AMT (enable/disable). Allows you to enable or disable functions of the embedded
Management Engine (ME) such as Active Management Technology (AMT). If set to disable,
the Management Engine is set to a temporarily disabled state and will not provide functions
beyond necessary system configuration. Default is enabled.

e  Unconfigure AMT/ME (enable/disable). Allows you to unconfigure any provisioned
management settings for AMT. The AMT settings are restored to factory defaults. This
feature should be used with caution as AMT will not be able to provide any set AMT
management functions once unconfigured. Default is disabled.

e Hide Unconfigure ME Confirmation Prompt (enable/disable). Allows you to set the system to
not display the confirmation to unconfigure ME.

e  Watchdog Timer (enable/disable). Allows you to set amount of time for a operating system
and BIOS watchdog alert to be sent if the timers are not deactivated. BIOS watchdog is
deactivated by BIOS and would indicate that a halt occurred during execution if the alert is
sent to the management console. An operating system alert is deactivated by the operating
system image and would indicate that a hang occurred during its initialization. Default is
enabled.

Recovering the Configuration Settings

This method of recovery requires that you first perform the Save to Removable Media command
with the Computer Setup (F10) Utility before Restore is needed. (See Computer Setup—File
on page 12 in the Computer Setup—File table.)

E’%NOTE: It is recommended that you save any modified computer configuration settings to a USB
flash media device and save the device for possible future use.

To restore the configuration, insert the USB flash media device with the saved configuration and
perform the Restore from Removable Media command with the Computer Setup (F10) Utility. (See
Computer Setup—File on page 12 in the Computer Setup—File table.)

Recovering the Configuration Settings
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4 Serial ATA (SATA) Drive Guidelines
and Features

@NOTE: HP only supports the use of SATA hard drives on these models of computer. No Parallel
ATA (PATA) drives are supported.

SATA Hard Drives

Serial ATA Hard Drive Characteristics

Number of pins/conductors in data cable 77

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)
Data interface voltage differential 400-700 mV
Drive voltages 33V,5V,12V
Jumpers for configuring drive N/A

Data transfer rate 3.0 Gb/s

SATA Hard Drive Cables

SATA Data Cable

Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA
1.5 Gb/s drives.

Current HP desktop products ship with SATA 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and
never bend it tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.
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SMART ATA Drives

The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.

Hard Drive Capacities

The combination of the file system and the operating system used in the computer determines the
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that may
be properly accessed by the operating system. A single hard drive may therefore be subdivided into a
number of unique drive partitions in order to make use of all of its space.

Because of the differences in the way that drive sizes are calculated, the size reported by the
operating system may differ from that marked on the hard drive or listed in the computer specification.
Drive size calculations by drive manufacturers are bytes to the base 10 while calculations by
Microsoft are bytes to the base 2.

Drive/Partition Capacity Limits

Maximum Size

File System Controller Type Operating System Partition Drive
FAT 32 ATA Windows 7 32GB 2TB
NTFS ATA Windows 7 2TB 2TB
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5 Routine Care and Disassembly
Preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

ACAUTION: When the computer is plugged into an AC power source, voltage is always applied to
the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.

26 Chapter 5 Routine Care and Disassembly Preparation



Electrostatic Discharge Information

A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive

devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work
perfectly throughout a normal cycle. The device may function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the
discharge contains enough power to alter device parameters or melt silicon junctions.

Generating Static
The following table shows that:
e Different activities generate different amounts of static electricity.

e  Static electricity increases as humidity decreases.

Relative Humidity

Event 55% 40% 10%
Walking across carpet 7,500 V 15,000 V 35,000 V
Walking across vinyl floor 3,000V 5,000V 12,000 V
Motions of bench worker 400 V 800V 6,000 V
Removing DIPs* from plastic tube 400 V 700V 2,000 V
Removing DIPs* from vinyl tray 2,000 V 4,000 V 11,500 V
Removing DIPs* from Styrofoam 3,500 V 5,000V 14,500 V
Removing bubble pack from PCB 7,000V 20,000 V 26,500 V
Packing PCBs in foam-lined box 5,000 V 11,000 V 21,000 V

*These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

r__*:"/?NOTE: 700 volts can degrade a product.

Preventing Electrostatic Damage to Equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the
degree of sensitivity. The following packaging and grounding precautions are necessary to prevent
damage to electric components and accessories.

e To avoid hand contact, transport products in static-safe containers such as tubes, bags, or
boxes.

e Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

e Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

e Place items on a grounded surface before removing them from their container.

Electrostatic Discharge Information
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Always be properly grounded when touching a sensitive component or assembly.
Avoid contact with pins, leads, or circuitry.

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
conductive foam.

Personal Grounding Methods and Equipment

Use the following equipment to prevent static electricity damage to equipment:

Wrist straps are flexible straps with a maximum of one-megohm + 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on
both feet with a maximum of one-megohm + 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage
Antistatic plastic 1,500
Carbon-loaded plastic 7,500
Metallized laminate 15,000

Grounding the Work Area

To prevent static damage at the work area, use the following precautions:

Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

Use static-dissipative mats, foot straps, or air ionizers to give added protection.

Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

Turn off power and input signals before inserting and removing connectors or test equipment.

Use fixtures made of static-safe materials when fixtures must directly contact dissipative
surfaces.

Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended Materials and Equipment

Materials and equipment that are recommended for use in preventing static electricity include:

Antistatic tape

Antistatic smocks, aprons, or sleeve protectors

28 Chapter 5 Routine Care and Disassembly Preparation



Conductive bins and other assembly or soldering aids

Conductive foam

Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance
Static-dissipative table or floor mats with hard tie to ground

Field service kits

Static awareness labels

Wrist straps and footwear straps providing one-megohm +/- 10% resistance
Material handling packages

Conductive plastic bags

Conductive plastic tubes

Conductive tote boxes

Opaque shielding bags

Transparent metallized shielding bags

Transparent shielding tubes

Operating Guidelines

To prevent overheating and to help prolong the life of the computer:

Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and
cold.

Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all
vented sides of the computer and above the monitor to permit the required airflow.

Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign
matter can block the vents and limit the airflow. Be sure to unplug the computer before cleaning
the air vents.

Never operate the computer with the cover removed.

Do not place computers so near each other that they are subject to each other’s re-circulated or
preheated air.

Keep liquids away from the computer and keyboard.
Never cover the ventilation slots on the monitor with any type of material.

Install or enable power management functions of the operating system or other software,
including sleep states.

Operating Guidelines
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Routine Care

General Cleaning Safety Precautions

1.
2,

3
4,
5
6

Never use solvents or flammable solutions to clean the computer.

Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and
then use the cloth on the component.

Always unplug the computer when cleaning with liquids or damp cloths.
Always unplug the computer before cleaning the keyboard, mouse, or air vents.
Disconnect the keyboard before cleaning it.

Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case

Follow all safety precautions in General Cleaning Safety Precautions on page 30 before cleaning the
computer.

To clean the computer case, follow the procedures described below:

To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

After cleaning, always wipe the unit with a clean, lint-free cloth.

Occasionally clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.

Cleaning the Keyboard

Follow all safety precautions in General Cleaning Safety Precautions on page 30 before cleaning the
keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 30.

When cleaning debris from under the keys, review all rules in General Cleaning Safety Precautions
on page 30 before following these procedures:

/\ CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.
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Visible debris underneath or between the keys may be removed by vacuuming or shaking.

Canned, pressurized air may be used to clean debris from under the keys. Caution should be
used as too much air pressure can dislodge lubricants applied under the wide keys.
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e If you remove a key, use a specially designed key puller to prevent damage to the keys. This
tool is available through many electronic supply outlets.

/\ CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these
keys are improperly removed or installed, the keyboard may not function properly.

e Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed
out. Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to
remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the Monitor

e  Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

e To clean the monitor body follow the procedures in Cleaning the Computer Case on page 30.

Cleaning the Mouse
Before cleaning the mouse, ensure that the power to the computer is turned off.

e Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out
any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

e To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 30.

Service Considerations

Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Tools and Software Requirements
To service the computer, you need the following:
e Torx T-15 screwdriver (HP screwdriver with bits, PN 161946-001)
e Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)
e  Phillips #2 screwdriver
e Diagnostics software

e HP tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or HP tamper-
resistant bits (Smart Cover FailSafe Key, PN 166527-002)

Screws

The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with
the part that was removed, then returned to their proper locations.

/\ CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.
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Cables and Connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with
care to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or
removal from the connector. Handle cables by the connector whenever possible. In all cases, avoid
bending or twisting the cables, and ensure that the cables are routed in such a way that they cannot
be caught or snagged by parts being removed or replaced.

/\ CAUTION: When servicing this computer, ensure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the computer.

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
applies to failed drives as well as replacement spares.

e If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

e Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

e Avoid dropping drives from any height onto any surface.

e If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.

e Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector. For more information about preventing electrostatic
damage, refer to Electrostatic Discharge Information on page 27

e Do not use excessive force when inserting a drive.

e Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic
fields such as monitors or speakers.

Lithium Coin Cell Battery

The battery that comes with the computer provides power to the real-time clock and has a minimum
lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this
guide for instructions on the replacement procedures.

/\ WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose
in water or fire, or expose it to temperatures higher than 140°F (60°C). Do not attempt to recharge the
battery.

@NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, their authorized partners, or their agents.
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6 Removal and Replacement Procedures

All-in One (AlO) Chassis

The following sections provide information about disassembling various components of the computer.

Preparing to Disassemble the Computer

To avoid injury and equipment damage, always complete the following steps in order, when opening
the HP Pro All-in-One.

1.
2.

Remove all media (CD, DVD, etc.) from the computer.
Shut down the computer.

After the system has completely shut down, disconnect the power adapter from the back of the
computer.

Disconnect all other attached cables from the back of the computer.

Place the computer face down on a soft flat surface. HP recommends that you set down a

blanket, towel, or other soft cloth to protect the screen surface from scratches or other damage.

/\ WARNING! Beware of sharp edges inside the chassis.

Preparing to Disassemble the Computer
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Hinge Cover Panel

The hinge cover panel is located above the stand. You must remove it to remove the drive access
panel and memory access panel.

Figure 6-1 Hinge cover panel location

To remove the hinge cover panel:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).
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2. Remove the hinge cover panel by pulling outward on the panel at the slot on the top edge of the
panel.

Figure 6-2 Removing the hinge cover panel

To replace the hinge cover panel, reverse the removal procedures.
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Memory Access Panel

The memory access panel is located on the rear, right side of the computer (viewed from behind).
You must remove it to access the memory modules and RTC battery.

Figure 6-3 Memory access panel location

To remove the memory access panel:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

2. Remove the center access panel (see Hinge Cover Panel on page 34).
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3. Open the latch securing the memory access panel.

Figure 6-4 Opening the memory access panel latch

4. Toremove the memory access panel, press down on the tab on the inside edge of the panel (1)
and slide the panel off the computer (2).

Figure 6-5 Removing the memory access panel

To replace the memory access panel, reverse the removal procedures.
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Drive Access Panel

The drive access panel is located on the rear, left side of the computer (viewed from behind). You
must remove it to access the hard drive and optical drive.

Figure 6-6 Drive access panel location

To remove the drive access panel:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

2. Remove the center access panel (see Hinge Cover Panel on page 34).
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3. Open the latch securing the drive access panel.

Figure 6-7 Opening the drive access panel latch

4. To remove the drive access panel, push downward on the tab on the inside edge of the panel (1)
and slide the panel off the computer (2).

Figure 6-8 Removing the drive access panel

To replace the drive access panel, reverse the removal procedures.
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Optical Drive

The optical drive is located under the drive access panel on the left side of the computer (viewed from
behind). It is secured with one Torx screw.

Figure 6-9 Optical drive location

To remove the optical drive:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

2. Remove the center access panel (see Hinge Cover Panel on page 34).

3.  Remove the drive access panel (see Drive Access Panel on page 38).

4. Remove the screw through the tab on the end of the drive that secures the drive to the
computer.

Figure 6-10 Removing the optical disc drive security screw
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5. Using your fingers, press the visible edge of the optical disc drive toward the side of the
computer to push the drive partially out of the computer. Grasp the front end of the drive and pull

the drive out of the computer.

Figure 6-11 Removing the optical disc drive

6. If you need to remove the drive bracket from the drive, remove the two screws (1) that secure
the bracket to the drive, and then remove the bracket from the drive (2).

@NOTE: Optical drive spare part kits do not include replacement brackets.

Figure 6-12 Removing the optical drive bracket
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To install an optical drive, reverse the removal procedures.

Optical Drive
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Hard Drive

The hard drive is located under the drive access panel on the left side of the computer (viewed from
behind). The drive is secured with one captive Torx screw and is housed in a removable cage.

Figure 6-13 Hard drive location

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

2. Remove the center access panel (see Hinge Cover Panel on page 34).

3.  Remove the drive access panel (see Drive Access Panel on page 38).

4. Loosen the captive screw next to the front of the drive that secures the drive to the computer.

Figure 6-14 Loosening the hard drive security screw

42 Chapter 6 Removal and Replacement Procedures All-in One (AIO) Chassis



5. Grasp the handle on top of the hard drive cage (1) and slide the cage toward the outer edge of
the computer, then lift the cage out of the computer (2).

Figure 6-15 Removing the hard drive cage

6. Remove the four mounting screws that secure the drive to the cage. Do not remove the blue
rubber grommets behind each screw. They must stay attached to the cage when installing a new
hard drive.

Figure 6-16 Removing the hard drive mounting screws
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7. Slide the hard drive out of the cage.

Figure 6-17 Removing the hard drive from the cage

To replace the hard drive, reverse the removal procedures.

@NOTE: If you choose to install an optional 2.5-inch solid state drive (SSD) or self-encrypting drive
(SED), you must mount that drive in a drive adapter, and then install the assembly in the hard drive
cage as you would a 3.5-inch hard drive.
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Memory

Memory modules are located on the right side of the computer (viewed from behind) under the
memory access panel. The computer has two memory slots.

Figure 6-18 Memory module location

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) small outline dual inline memory modules (SODIMMs).

The memory sockets on the system board can be populated with up to two industry-standard
SODIMMs. These memory sockets are populated with at least one preinstalled SODIMM. To achieve
the maximum memory support, you can populate the system board with up to 16 GB of memory.

For proper system operation, the SODIMMs must be:

e industry-standard 204-pin

e unbuffered non-ECC PC3-10600 DDR3-1600 MHz-compliant

e 1.5 volt DDR3-SDRAM SODIMMs

The DDR3-SDRAM SODIMMs must also:

e support CAS latency 9 DDR3 1600 MHz (9-9-9 timing)

e contain the mandatory Joint Electronic Device Engineering Council (JEDEC) specification
In addition, the computer supports:

e  512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

e single-sided and double-sided SODIMMS

e SODIMMs constructed with x8 and x16 devices; SODIMMs constructed with x4 SDRAM are not
supported

r__*:%NOTE: The system will not operate properly if you install unsupported SODIMMs.
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The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the SODIMMSs are installed. Refer to the following table to identify the SODIMM
channel locations.

Table 6-1 Identifying SODIMM locations

Location System Board Label Channel
Lower Socket DIMMO Channel B
Upper Socket DIMMO Channel A

e  The system will operate in single channel mode if the SODIMM sockets are populated in one
channel only.

e  The system will operate in a higher-performing dual channel mode if the memory capacity of the
SODIMM in Channel A is equal to the memory capacity of the SODIMM in Channel B.

e  The system will operate in flex mode if the memory capacity of the SODIMM in Channel A is not
equal to the memory capacity of the SODIMM in Channel B. In flex mode, the channel populated
with the least amount of memory describes the total amount of memory assigned to dual
channel and the remainder is assigned to single channel. If one channel will have more memory
than the other, the larger amount should be assigned to channel A.

e In any mode, the maximum operational speed is determined by the slowest SODIMM in the
system.

There are two memory sockets on the system board located behind the memory access panel. To
remove or install memory modules:

To remove a memory module:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

2. Place the computer face down on a soft flat surface. HP recommends that you set down a
blanket, towel, or other soft cloth to protect the screen surface from scratches or other damage.

3.  Remove the center access panel (see Hinge Cover Panel on page 34).

4. Remove the memory access panel (see Memory Access Panel on page 36).
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Pull upward on the raised tab on the memory cover and lift the cover off the computer.

Figure 6-19 Removing the memory cover

To remove a memory module, press outward on the two latches on each side of the SODIMM
(1), then pull the SODIMM out of the socket (2).

Figure 6-20 Removing a memory module
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To install a memory module, slide the SODIMM into the socket at approximately a 30° angle (1),
then press the SODIMM down (2) so that the latches lock it in place (3).

Figure 6-21 Installing a memory module

|‘__°:"%NOTE: A memory module can be installed in only one way. Match the notch on the module
with the tab on the memory socket.

8. Press the memory cover back in place. Insert the bottom edge of the memory cover into the
sheet metal shielding first, then press the top edge of memory cover down. Ensure that all the
tabs on the memory cover are pressed firmly against the sheet metal shielding.

Figure 6-22 Replacing the memory cover

The computer automatically recognizes the additional memory when you turn on the computer.
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Replacing the Battery

The RTC battery is located near the memory modules under the memory access panel.

Figure 6-23 Battery location

The battery is located in the memory compartment. The battery that comes with the computer
provides power to the real-time clock. When replacing the battery, use a battery equivalent to the
battery originally installed in the computer. The computer comes with a 3-volt lithium coin cell battery.

AWARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 60° C (140° F).

Do not disassembile, crush, puncture, short external contacts, or dispose of in fire or water.
Replace the battery only with the HP spare designated for this product.

/\ CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared.

Static electricity can damage the electronic components of the computer or optional equipment.

Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object.
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@NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/

recycle.

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

2. Remove the center access panel (see Hinge Cover Panel on page 34).

3.  Remove the memory access panel (see Memory Access Panel on page 36).

4. Pull upward on the raised tab on the memory cover and lift the cover off the computer.

Figure 6-24 Removing the memory cover

5. Depending on the type of battery holder on the system board, complete the following instructions
to replace the battery.

Type 1
a. Lift the battery out of its holder.

Figure 6-25 Removing a coin cell battery (Type 1)

b. Slide the replacement battery into position, positive side up. The battery holder
automatically secures the battery in the proper position.

50 Chapter 6 Removal and Replacement Procedures All-in One (AlO) Chassis


http://www.hp.com/recycle
http://www.hp.com/recycle

Type 2

a. Torelease the battery from its holder, squeeze the metal clamp that extends above one
edge of the battery. When the battery pops up, lift it out (1).

b. To insert the new battery, slide one edge of the replacement battery under the holder’s lip
with the positive side up. Push the other edge down until the clamp snaps over the other
edge of the battery (2).

Figure 6-26 Removing and replacing a coin cell battery (Type 2)

Type 3
a. Pull back on the clip (1) that is holding the battery in place, and remove the battery (2).
b. Insert the new battery and position the clip back into place.

Figure 6-27 Removing a coin cell battery (Type 3)
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Replacing the Battery 51



Heat Sink Cover

The heat sink cover protects the heat sink and system board. It is secured with five Torx screws.

Figure 6-28 Heat sink cover location
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To remove the heat sink cover:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

2. Remove the center access panel (see Hinge Cover Panel on page 34).

3.  Remove the memory access panel (see Memory Access Panel on page 36).

4. Remove the five black Torx screws that secure the cover to the computer.

Figure 6-29 Heat sink cover screws
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5. Lift the cover from the computer.

Figure 6-30 Removing the heat sink cover

To install the heat sink cover, reverse the removal procedures.
When installing the cover, be sure to insert the tabs from the cover into the slots in the computer.

Figure 6-31 installing the heat sink cover

Heat Sink Cover 53



Heat Sink (Thermal Module)

The heat sink is secured with five Torx screws — four captured, one not captured.

Figure 6-32 Heat sink location

To remove the heat sink:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the memory access panel (see Memory Access Panel on page 36).

Remove the drive access panel (see Drive Access Panel on page 38).

Remove the stand (see Stand on page 61).

Remove the heat sink cover (see Heat Sink Cover on page 52).
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Loosen the four silver captive Torx screws on the heat sink (1).

/\ CAUTION: Remove heat sink retaining screws in diagonally opposite pairs (as in an X) to even
the downward forces on the processor. This is especially important as the pins on the socket are
very fragile and any damage to them may require replacing the system board.
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8. Remove the black Torx screw from the top of the heat sink (2).

Figure 6-33 Loosening and removing the heat sink screws

9. Lift the heat sink from the computer.

Figure 6-34 Removing the heat sink

/\ CAUTION: To reduce a degradation in thermal performance, be sure not to touch the thermal
grease on the surface of the processor or the heat sink.

To replace the heat sink, reverse the removal procedures.

Heat Sink (Thermal Module)
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Processor

1.
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Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the memory access panel (see Memory Access Panel on page 36).

Remove the drive access panel (see Drive Access Panel on page 38).

Remove the heat sink cover (see Heat Sink Cover on page 52).

Remove the heat sink (see Heat Sink (Thermal Module) on page 54).

Rotate the locking lever to its full open position (1).
Raise and rotate the microprocessor retainer to its fully open position (2).

Carefully lift the processor from the socket (3).

/\ CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and

handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

The heat sink must be installed within 24 hours of installing the processor to prevent damage to
the processor’s solder connections.

Figure 6-35 Removing the processor

To install a new processor:

1.
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Place the processor in its socket and close the retainer. Make sure the slot in the processor fits
into the post on the socket.

Secure the locking lever. If reusing the existing heat sink, go to step 3. If using a new heat sink,
go to step 6.
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3. If reusing the existing fan sink, clean the bottom of the fan sink with the alcohol pad provided in
the spares kit.

/\ CAUTION: Before reinstalling the fan sink you must clean the top of the processor and the
bottom of the fan sink with an alcohol pad supplied in the spares kit. After the alcohol has
evaporated, apply thermal grease to the top of the processor from the syringe supplied in the
spares kit.

4. Apply the thermal grease provided in the spares kit to the top of the processor and install the fan
sink atop the processor.

5. Gotostep?7.

6. If using a new fan sink, remove the protective covering from the bottom of the fan sink and place
it in position atop the processor.

7. Secure the fan sink to the system board and system board tray.

/\ CAUTION: Fan sink retaining screws should be tightened in diagonally opposite pairs (as in an
X) to evenly seat the fan sink on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.

|‘__*:"/i"NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can
be found on the Web at: http://h18000.www1.hp.com/support/files.
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Top Panel

The top panel is secured with two Torx screws. Removing it allows access to the webcam and allows
you to remove the main rear cover.

Figure 6-36 Top panel location

To remove the top panel:

1.
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Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the memory access panel (see Memory Access Panel on page 36).

Remove the drive access panel (see Drive Access Panel on page 38).

On the top of the computer, remove the two black Torx screws (1) that secure the top panel to
the computer.

Rotate the top of the panel outward (2), and then lift the panel off the computer.

Figure 6-37 Removing the top panel

To replace the top panel, reverse the removal procedures.
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Webcam Module

The webcam module is located at the top of the computer beneath the top panel. It is secured with
two silver Phillips screws and has one connector.

Figure 6-38 Webcam module location

To remove the webcam module:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the memory access panel (see Memory Access Panel on page 36).

Remove the drive access panel (see Drive Access Panel on page 38).
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Remove the top panel (see Top Panel on page 58).
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6. Remove the two silver Phillips screws that secure the webcam module to the computer.

Figure 6-39 Webcam module screws

u

7. As far as the cable allows, remove the webcam module from the computer, and then disconnect
the cable from the module.

Figure 6-40 Disconnecting the web
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cam module

To install a webcam module, reverse the removal procedures.
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Stand

The stand is secured with three Torx screws. You must remove the center access panel to remove
the stand.

To remove the stand:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the three silver Torx screws (1) that secure the stand to the computer.

Lift the memory and drive access panel latches (2).
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Slide the stand toward the top of the computer slightly (3), and then lift the stand off the
computer (4).

Figure 6-41 Removing the stand

To replace the stand, reverse the removal procedures.
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Rear Cover

The rear cover is secured with four Torx screws. The optical drive security screw also secures the
rear cover. After removing the screws, you must pry it off at the seams around the edges of the
computer.

To remove the rear cover:

1.
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Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the memory access panel (see Memory Access Panel on page 36).

Remove the drive access panel (see Drive Access Panel on page 38).

Remove the stand (see Stand on page 61).

Remove the optical drive (see Optical Drive on page 40).

Remove the top panel (see Top Panel on page 58).

Remove the five black Torx screws that secure the rear panel to the computer (1).

Pry the cover off the computer by pulling the top edge (2) loose, then prying the side loose near
the memory modules (3), bottom side (4), and left side (5).

E’%NOTE: The cover may be very tight and difficult to remove.

Figure 6-42 Removing the rear cover

10. Remove the rear cover from the computer.

To replace the rear cover, reverse the removal procedures.
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Fan

The fan is located near the middle of the computer under the main rear cover. The fan is secured with
three Torx screws. You do not have to remove the heat sink to remove the fan.

Figure 6-43 Fan assembly location

To remove th
1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the memory access panel (see Memory Access Panel on page 36).

Remove the drive access panel (see Drive Access Panel on page 38).

Remove the stand (see Stand on page 61).

Remove the optical drive (see Optical Drive on page 40).

Remove the heat sink cover (see Heat Sink Cover on page 52).

Remove the top panel (see Top Panel on page 58).
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Remove the rear cover (see Rear Cover on page 62).

Fan
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10. Remove the three black Torx screws that secure the fan to the computer, and then disconnect
the fan cable from the system board connector labeled CHASSIS_FAN1.

Figure 6-44 Fan screws

11. Slide the fan toward the right to remove it from underneath the metal bracket, and then lift the

fan from the computer.

Figure 6-45 Removing the fan

To install the fan assembly, reverse the removal procedures.
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Converter Board

The converter board is located on the left side of the computer (viewed from behind) under the main
rear cover. It is secured with two Torx screws and has two connectors.

Figure 6-46 Converter board location

To remove th
1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the memory access panel (see Memory Access Panel on page 36).

Remove the drive access panel (see Drive Access Panel on page 38).

Remove the stand (see Stand on page 61).

Remove the optical drive (see Optical Drive on page 40).

Remove the top panel (see Top Panel on page 58).

Remove the rear cover (see Rear Cover on page 62).
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Disconnect the two cables from the board (1).

E%‘fNOTE: Be careful not to damage the cables when disconnecting them from the board. Do not
pull on the wires.

10. Remove the two silver Torx screws (2) that secure the board to the computer.
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11. Lift the converter board from the computer.

Figure 6-47 Removing the converter board
- ——
-
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Be sure to correctly position the jumpers on the converter board for the installed display panel,
as follows:

/\ CAUTION: Incorrect jumper placement can result in damage to the converter board.

e LG panel: pins (1)(2) & (3)(4)
e  Samsung panel: pins (3)(4) & (5)(6)
e  CMIl panel: pins (1)(2) & (5)(6)

LG Samsung

To install the converter board, reverse the removal procedures.
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Sidekey Board

The sidekey board is located on the bottom left side of the computer (viewed from behind) under the
main rear cover. It is secured with two Torx screws and has one connector.

The associated cable connects to the front power switch assembly. To remove this cable, you must
remove the stand bracket, disassembly of which is shown later in this document at Stand bracket

on page 75.
Figure 6-48 Sidekey board location

To remove the_ éidekéy_ board:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the memory access panel (see Memory Access Panel on page 36).

Remove the drive access panel (see Drive Access Panel on page 38).

Remove the stand (see Stand on page 61).

Remove the optical drive (see Optical Drive on page 40).

Remove the top panel (see Top Panel on page 58).
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Remove the rear cover (see Rear Cover on page 62).
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9. Disconnect the cable from the sidekey board.

E’%NOTE: Be careful not to damage the cable when disconnecting it from the board. Do not pull
on the wires.

Figure 6-49 Disconnecting the sidekey board cable

10. Remove the two silver Torx screws that secure the board to the computer.

Figure 6-50 Sidekey board screws
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11. Rotate the bottom of the board upward, and then remove the board from the computer.

Figure 6-51 Removing the sidekey board

To install the sidekey board, reverse the removal procedures.

System Board Shield

The system board shield covers the bottom of the system board. It is secured with two Torx screws
and two hex screws around the serial port.

Figure 6-52 System board shield location

System Board Shield
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To remove the system board shield:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the memory access panel (see Memory Access Panel on page 36).

Remove the drive access panel (see Drive Access Panel on page 38).

Remove the stand (see Stand on page 61).

Remove the optical drive (see Optical Drive on page 40).

Remove the top panel (see Top Panel on page 58).

Remove the heat sink cover (see Heat Sink Cover on page 52).
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Remove the rear cover (see Rear Cover on page 62).

10. Remove the two black Torx screws (1) that secure the shield to the computer.

E’%NOTE: The Torx screw in the lower left also secures the stand bracket.

11. Remove the two silver hex screws around the serial port (2).
12. Lift the shield from the computer.

oard shi

L

eld

Figure 6-53 Removing the system b

To install the system board shield, reverse the removal procedures.
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WLAN Module

The WLAN module is located on the bottom left of the system board. The module is secured with one

Phillips screw and has two connected antennas.

Figure 6-54 WLAN module location

To remove the WLAN module:

1.
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Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the memory access panel (see Memory Access Panel on page 36).

Remove the drive access panel (see Drive Access Panel on page 38).

Remove the stand (see Stand on page 61).

Remove the optical drive (see Optical Drive on page 40).

Remove the top panel (see Top Panel on page 58).

Remove the rear cover (see Rear Cover on page 62).

Remove the heat sink cover (see Heat Sink Cover on page 52).

Remove the system board shield (see System Board Shield on page 69).

WLAN Module
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11. Disconnect the antenna cables from the module (1).
12. Remove the Phillips screw (2) that secures the module to the computer.

Figure 6-55 Removing the WLAN module screw and antennas

13. Lift the module to a 45-degree angle, and then pull it away to remove it from the socket.

Figure 6-56 Removing the WLAN module

To install the WLAN module, reverse the removal procedures.

@NOTE: WLAN modules are designed with a notch to prevent incorrect insertion.
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Speakers

The speakers are located at the bottom of the computer. Two separate speakers are each secured by
two Torx screws and have separate cables and system board connectors.

Figure 6-57 Speaker location

To remove the speakers:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the memory access panel (see Memory Access Panel on page 36).

Remove the drive access panel (see Drive Access Panel on page 38).

Remove the stand (see Stand on page 61).

Remove the optical drive (see Optical Drive on page 40).

Remove the heat sink cover (see Heat Sink Cover on page 52).

Remove the top panel (see Top Panel on page 58).
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Remove the rear cover (see Rear Cover on page 62).

10. Remove the system board shield (see System Board Shield on page 69).

11. Remove two Torx screws that secure each speaker to the computer.

12. Disconnect the speaker cables from the system board connectors . The left speaker connects to
the white connector labeled LFT_SPKR. The right speaker connects to the black connector
labeled RT_SPKR.
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13. Remove the speakers from the computer.

Figure 6-58 Removing the speakers

To install the speakers, reverse the removal procedures.
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Stand bracket

The stand bracket is located near the middle of the computer, below the fan. Remove the bracket to
gain access to the drive cables and sidekey board cable assembly. The bracket is secured with four
Torx screws.

Figure 6-59 Stand bracket location

To remove the stand bracket:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the memory access panel (see Memory Access Panel on page 36).

Remove the drive access panel (see Drive Access Panel on page 38).

Remove the stand (see Stand on page 61).

Remove the optical drive (see Optical Drive on page 40).

Remove the top panel (see Top Panel on page 58).
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Remove the rear cover (see Rear Cover on page 62).

Stand bracket



9. Remove the four black Torx screws that secure the stand bracket to the computer.

E’%NOTE: The bottom right corner of the stand bracket shares a screw with the system board
cover. If you have not removed the system board cover prior to removing the stand bracket, you
will need to remove this screw to remove the stand bracket.

Figure 6-60 Stand bracket screw locations

10. Lift the bracket from the computer.

Figure 6-61 Removing the stand bracket

To install the stand bracket, reverse the removal procedures.

= NOTE: When reinstalling the stand bracket, be sure to insert the right side of the bracket
underneath the system board cover.
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System Board

The system board is located on the right side of the computer (viewed from the rear) under the heat
sink and system board covers. It is secured with right Torx screws.

Figure 6-62 System board location

To remove the system board:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the memory access panel (see Memory Access Panel on page 36).

Remove the memory modules (see Memory on page 45).

Remove the drive access panel (see Drive Access Panel on page 38).

Remove the stand (see Stand on page 61).

Remove the optical drive (see Optical Drive on page 40).

Remove the heat sink cover (see Heat Sink Cover on page 52).
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Remove the thermal module/heat sink (see Heat Sink (Thermal Module) on page 54).

10. Remove the top panel (see Top Panel on page 58).

11. Remove the rear cover (see Rear Cover on page 62).

12. Remove the system board cover (see System Board Shield on page 69).

13. Remove the WLAN module (see WLAN Module on page 71).

14. Remove the processor (see Processor on page 56).

15. Disconnect all cables from the system board, noting their location for reinstallation.

System Board



16. Remove the eight silver Torx screws (circled in image) that secure the system board to the
computer.

Figure 6-63 System board screw locations

17. Lift the system board straight up and out of the computer.

E%NOTE: The thermal material on the bottom of the system board may cause it to stick to the
computer.

@NOTE: Before returning the defective system board, remove the CPU cover from the replacement
system board and install it on the defective system board.

To install the system board, reverse the removal procedures.

Updating SMBIOS Information

When replacing the system board, you must reprogram the SMBIOS information on the affected
computer. Failure to reprogram the board will result in eventual failure, such as an activation failure
(need to reactivate the system) or a system recovery failure.

To update SMBIOS information in Computer Setup:
1. Turn on or restart the computer.

2. Press Esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom
of the screen.

@NOTE: If you do not press Esc at the appropriate time, you must restart the computer and
again press Esc when the monitor light turns green to access the utility.
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Press F10 to enter Computer Setup.
Go to Security > System ID’s.

If necessary, press Ctrl+A to initiate edit mode.

cannot be edited.

System ID Setup Page

Edit the fields listed. If the feature byte has data or is not editable, then it was not cleared and

Setup Field Name Comment Label
Product Name Enter the Model name/number or marketing name. Flexbuild
Serial Number Enter the Serial Number of Unit. Support
SKU Number Enter the SKU or Product Number including Localization Code. Support
Asset Tag Enter the 18-byte identifier assigned to the computer. Support
Feature Byte Enter the Feature Byte string. The feature byte string is case dependent. Flexbuild

The label includes spaces after every four characters. You can enter or

ignore these spaces — their only purpose is to help with data entry. There is

a character limitation of 40 bytes per line. When you reach this limit, go to

the next line to continue data entry. BIOS ignores the spaces and lines.

If you make an error during data entry, the data will not validate, and the

computer asks you to correct your data input.
Build ID The Build ID of the unit. Flexbuild
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Hard Drive and Optical Drive Cables and Connectors

The hard drive and optical drive connectors are located near the middle of the computer, partially
under the bracket that secures the stand. Each connector is secured with two Torx screws and has
two cables that connect to the system board.

The optical drive connector cables are longer than the hard drive connector cables.

To remove the hard drive or optical drive connector:

1.
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Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the memory access panel (see Memory Access Panel on page 36).

Remove the drive access panel (see Drive Access Panel on page 38).

Remove the stand (see Stand on page 61).

Remove the hard drive (see Hard Drive on page 42).

Remove the optical drive (see Optical Drive on page 40).

Remove the top panel (see Top Panel on page 58).

Remove the rear cover (see Rear Cover on page 62).

Remove the system board cover (see Heat Sink Cover on page 52).

Remove the stand bracket (see Stand bracket on page 75).

Remove two Torx screws that secure the hard drive connector (1) or the optical drive connector
(2) to the computer.

Remove the cables from the metal clips (3) built into the computer.
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14. Disconnect the hard drive cables (4) or the optical drive cables (5) from the system board.

@NOTE: Be careful not to damage the cable when disconnecting it from the board. Do not pull
on the wires.

15. Remove the connector from the computer.

Figure 6-65 Removing the hard drive or optical drive connectors

To install the hard drive or optical drive connector, reverse the removal procedures.
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Display Cable

The main display cable connector is located behind the system board. You must remove the system
board to remove the display cable.

Figure 6-66 Display cable location
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To remove the display cable:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer

on page 33).
2. Remove the center access panel (see Hinge Cover Panel on page 34).
3.  Remove the memory access panel (see Memory Access Panel on page 36).
4. Remove the drive access panel (see Drive Access Panel on page 38).
5. Remove the stand (see Stand on page 61).
6. Remove the optical drive (see Optical Drive on page 40).
7. Remove the heat sink cover (see Heat Sink Cover on page 52).
8. Remove the heat sink (see Heat Sink (Thermal Module) on page 54.
9. Remove the top panel (see Top Panel on page 58).
10. Remove the rear cover (see Rear Cover on page 62).
11. Remove the system board shield (see System Board Shield on page 69).
12. Remove the system board (see System Board on page 77).
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13. Disconnect the cable from the display panel by pressing in the latches on the side of the cable
(1) and pulling it from the connector (2).

Figure 6-67 Removing the display cable
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To install the display cable, reverse the removal procedures.
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Front Bezel

The front bezel is located on the front of the computer and is secured to the main system bracket with
five Torx screws and nine tabs.

You can remove the front bezel without disassembling many of the computer's components. Most
components can remain attached to the base pan. The following procedure demonstrates removing
the bezel while removing the smallest number of components possible.

To remove the front bezel:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the memory access panel (see Memory Access Panel on page 36).
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Remove the drive access panel (see Drive Access Panel on page 38).

Remove the top panel (see Top Panel on page 58).

Remove the rear cover (see Rear Cover on page 62).

Remove the speakers (see Speakers on page 73).
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Remove the power switch assembly cable from the front bezel. You do not have to remove the
remaining cables.

9. Remove the five black Torx screws that secure the bezel to the main system bracket assembly.

10. Lift the nine tabs (see arrows in image) that secure the bezel to the main system bracket
assembly. Be sure to slide the bracket free from the tabs as you lift each one.
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11. Lift the main system bracket assembly off the front bezel.

Figure 6-68 Removing the front bezel assembly from the computer

12. Lift the main display panel assembly from the front bezel.

To install the front bezel, reverse the removal procedures.

Display Panel

If you disconnect the display cable from the display panel, you do not have to remove the system
board to replace the display panel.

Three different display panels are available — LG, Samsung, and CMI.

Display panels require a backlight cable specific to the manufacturer. Make sure you use the
backlight cable packaged with the display panel.

The display panel is secured to the base pan with four Torx screws, as follows:
e CMI - two screws on top, two screws on the bottom

e LG and Samsung - two screws on each side but in different locations

To remove the display panel:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the memory access panel (see Memory Access Panel on page 36).

Remove the drive access panel (see Drive Access Panel on page 38).
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Remove the stand (see Stand on page 61).
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6. Remove the top panel (see Top Panel on page 58).

7. Remove the rear cover (see Rear Cover on page 62).

8. Remove the power switch assembly from the front bezel (see Power Switch Assembly
on page 89).

= NOTE: After you remove the power switch assembly with LED and cable from the front bezel,
you do not have to remove the side key cable.

9. Remove the front bezel (see Front Bezel on page 84).

10. Disconnect the display cable from the display panel (1).

=¥ NOTE: Replace the backlight cable (2) with the new backlight cable that comes with the new
display panel kit.

Remove the backlight cable from the defective panel before sending the panel back to the
supplier.

Figure 6-69 Removing the display cable from the display panel
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11. Remove the four silver Torx screws that secure the display panel to the frame. The screw
locations for each manufacturer are stamped into the metal.

The LG (1) and Samsung (2) panels are secured with two screws on each side (left and right).

Figure 6-70 Display panel screw locations — LG or Samsung panels
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12. Lift the display panel from the frame.
13. Be sure to correctly position the jumpers on the converter board for the installed display panel,
as follows:

/\ CAUTION: Incorrect jumper placement can result in damage to the converter board and LCD
panel.
e LG panel: pins (1)(2) & (3)(4)

e  Samsung panel: pins (3)(4) & (5)(6)

e  CMI panel: pins (1)(2) & (5)(6)
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To install a display panel, reverse the removal procedures.
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Power Switch Assembly

The power switch assembly is located on the bottom corner of the inside of the front bezel. You must
remove the front bezel from the computer to remove the power switch assembly from the bezel.

Figure 6-72 Power switch assembly location

To remove the power switch assembly:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 33).

Remove the center access panel (see Hinge Cover Panel on page 34).

Remove the memory access panel (see Memory Access Panel on page 36).

Remove the drive access panel (see Drive Access Panel on page 38).

Remove the stand (see Stand on page 61).

Remove the optical drive (see Optical Drive on page 40).

Remove the top panel (see Top Panel on page 58).

Remove the rear cover (see Rear Cover on page 62).
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Remove the front bezel (see Front Bezel on page 84.
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Pull the two tabs (1) toward the bottom of the bezel, and then rotate the assembly up and off the
bezel (2).
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Pull the light pipe out of its slot (3).
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12. Remove the cable from the clip built into the bezel (4), and then remove the power switch
assembly from the front bezel.

Figure 6-73 Removing the power switch assembly

To install the power switch assembly, reverse the removal procedures.
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7 Troubleshooting Without Diagnostics

This chapter provides information on how to identify and correct minor problems, such as USB
devices, hard drive, optical drive, graphics, audio, memory, and software problems. If you encounter
problems with the computer, refer to the tables in this chapter for probable causes and recommended
solutions.

E/i"NOTE: For information on specific error messages that may appear on the screen during Power-On
Self-Test (POST) at startup, refer to Appendix A, POST Error Messages on page 143.

Safety and Comfort

/\ WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. For more information, refer to the Safety & Regulatory Information guide.

Before You Call for Technical Support

If you are having problems with the computer, try the appropriate solutions below to try to isolate the
exact problem before calling for technical support.

e  Run the HP diagnostic tool.

e Run the hard drive self-test in Computer Setup. Refer to Computer Setup (F10) Utility
on page 10 for more information.

e Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to Appendix A, POST Error
Messages on page 143 for more information.

e If the screen is blank, plug the monitor into a different video port on the computer if one is
available. Or, replace the monitor with a monitor that you know is functioning properly.

e If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

e If you recently added new hardware, remove the hardware and see if the computer functions
properly.

e If you recently installed new software, uninstall the software and see if the computer functions
properly.

e Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When
booting the operating system, use “Last Known Configuration.”
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e Refer to the comprehensive online technical support at http://www.hp.com/support.

e Refer to Helpful Hints on page 92 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with
self-solve diagnostics. If you need to contact HP support, use HP Instant Support Professional
Edition's online chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/

golispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online
support information, software and drivers, proactive notification, and worldwide community of peers
and HP experts.

If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that
your service call is handled properly:

e Be in front of your computer when you call.

e  Write down the computer serial number, product ID humber, and monitor serial number before
calling.

e Spend time troubleshooting the problem with the service technician.
e Remove any hardware that was recently added to your system.
e Remove any software that was recently installed.

e Restore the system from the Recovery Disc Set that you created or restore the system to its
original factory condition in System Software Requirement Disks (SSRD).

/\ CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data
files before running the restore process.

E/?’NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized
service provider or dealer.

Helpful Hints

If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:

e  Check that the computer and monitor are plugged into a working electrical outlet.

e Check that the voltage select switch (some models) is set to the appropriate voltage for your
region (115V or 230V).

e  Check that the computer is turned on and the green power light is on.
e  Check that the monitor is turned on and the green monitor light is on.

e  Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to Appendix A, POST Error
Messages on page 143 for more information.

e  Turn up the brightness and contrast controls of the monitor if the monitor is dim.
e Press and hold any key. If the system beeps, then the keyboard should be operating correctly.

° Check all cable connections for loose connections or incorrect connections.
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e Wake the computer by pressing any key on the keyboard or pressing the power button. If the
system remains in suspend mode, shut down the computer by pressing and holding the power
button for at least four seconds then press the power button again to restart the computer. If the
system will not shut down, unplug the power cord, wait a few seconds, then plug it in again. The
computer will restart if it is set to power on automatically as soon as power is restored in
Computer Setup. If it does not restart, press the power button to start the computer.

e Reconfigure the computer after installing a non-plug and play expansion board or other option.
See Solving Hardware Installation Problems on page 116 for instructions.

e Be sure that all the needed device drivers have been installed. For example, if you are using a
printer, you need a driver for that model printer.

e Remove all bootable media (CD/DVD or USB device) from the system before turning it on.

e If you have installed an operating system other than the factory-installed operating system,
check to be sure that it is supported on the system.

e If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed
(embedded video on some models only) and a single monitor, the monitor must be plugged into
the monitor connector on the source selected as the primary VGA adapter. During boot, the
other monitor connectors are disabled and if the monitor is connected into these ports, the
monitor will not function. You can select which source will be the default VGA source in
Computer Setup.

/\ CAUTION: When the computer is plugged into an AC power source, there is always voltage applied
to the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.
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Solving General Problems

You may be able to easily resolve the general problems described in this section. If a problem
persists and you are unable to resolve it yourself or if you feel uncomfortable about performing the

operation, contact an authorized dealer or reseller.

/\ WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to

cool before touching.

Table 7-1 Solving General Problems

Computer appears locked up and will not turn off when the power button is pressed.

Cause

Solution

Software control of the power switch is not functional.

1. Press and hold the power button for at least four
seconds until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to keyboard or mouse.

Cause

Solution

Computer is in Sleep state.

To resume from Sleep state, press the power button.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

System has locked up.

Restart computer.

Computer date and time display is incorrect.

Cause

Solution

RTC (real-time clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet
prolongs the life of the RTC battery.

Reset the date and time under Control Panel (Computer
Setup can also be used to update the RTC date and time). If
the problem persists, replace the RTC battery. See the
Removal and Replacement section for instructions on
installing a new battery, or contact an authorized dealer or
reseller for RTC battery replacement.

To access Control Panel in Windows 7, select Start, and
then select Control Panel.

To access Control Panel in Windows 8, from the Start
screen, type c, and then select Control Panel from the list of
applications.
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Cursor will not move using the arrow keys on the keypad.

Cause

Solution

The Num Lock key is turned on.

Press the Num Lock key. The Num Lock light must be off if
you want to use the arrow keys on the keypad. You can also
disable or enable the Num Lock key in Computer Setup at
Advanced > Device Options.

There is no sound or sound volume is too low.

Cause

Solution

System volume may be set low or muted.

1. Check the Computer Setup settings to make sure the
internal system speaker is not muted (this setting does
not affect the external speakers).

2. Make sure the external speakers are properly
connected and powered on and that the speakers'
volume control is set correctly.

3. Use the system volume control available in the
operating system to make sure the speakers are not
muted or to increase the volume.

Cannot remove computer cover or access panel.

Cause

Solution

Smart Cover Lock, featured on some computers, is locked.

Unlock the Smart Cover Lock using Computer Setup.

In case of forgotten password, power loss, or computer
malfunction, you must manually disable the Smart Cover
lock . A key to unlock the Smart Cover Lock is not available
from HP. Keys are typically available from a hardware store.

Poor performance.

Cause

Solution

Processor is too hot.

1. Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2. Make sure fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full.

Transfer data from the hard drive to create more space on
the hard drive.

Low on memory.

Add more memory.

Hard drive fragmented.

Defragment hard drive.

Program previously accessed did not release reserved
memory back to the system.

Restart the computer.
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Table 7-1 Solving General Problems (continued)

Poor performance.

Cause

Solution

Virus resident on the hard drive.

Run virus protection program.

Too many applications running.

Windows 7:

1.

2.

Close unnecessary applications to free up memory.

Add more memory.

Some applications run in the background and can be

closed by right-clicking on their corresponding icons in

the task tray. To prevent these applications from

launching at startup:

In Windows 7:

a. Go to Start > All Programs > Accessories > Run

b. Type msconfig, and then press Enter.

c. On the Startup tab of the System Configuration
Utility, clear applications that you do not want to
launch automatically, and the click OK.

In Windows 8:

a. On the Start screen, right-click, and then select the
All apps icon.

b. Under Windows System, click Run.
c. Typemsconfig, and then press Enter.
d. On the Startup tab of the System Configuration

Utility, clear applications that you do not want to
launch automatically, and the click OK.

Some software applications, especially games, are stressful
on the graphics subsystem.

1.

2

3.

Lower the display resolution for the current application
or consult the documentation that came with the
application for suggestions on how to improve
performance by adjusting parameters in the application.

Add more memory.

Upgrade the graphics solution.

Cause unknown.

Restart the computer.
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Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing).

Cause

Solution

Processor thermal protection activated:
A fan may be blocked or not turning.
OR

The heat sink is not properly attached to the processor.

1.

Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

Open the access panel, press the power button, and
see if the processor fan (or other system fan) spins. If
the fan does not spin, make sure the fan cable is
plugged onto the system board header.

If fan a plugged in and not spinning, replace it.

System does not power on and the LEDs on the front of the computer are not flashing.

Cause

Solution

System unable to power on.

Press and hold the power button for less than 4 seconds. If
the hard drive LED turns green, then:

1.

3.

OR

If equipped with a voltage selector, check that the
voltage selector (located on the rear of the power
supply) is set to the appropriate voltage. Proper voltage
setting depends on your region.

Remove the expansion cards one at a time until the
5V_aux light on the system board turns on.

Replace the system board.

Press and hold the power button for less than 4 seconds. If
the hard drive LED does not turn on green then:

1.

2.

Check that the unit is plugged into a working AC outlet.

Open the access panel and check that the power button
cable is properly connected to the system board.

Check that the power supply cables are properly
connected to the system board.

Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power
button assembly.

If the 5V_aux light on the system board is off, then
replace the power supply.

Replace the system board.
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Solving Power Problems

Common causes and solutions for power problems are listed in the following table.

Table 7-2 Solving Power Problems

Power supply shuts down intermittently.

Cause Solution

If equipped with a voltage selector, voltage selector switch Select the proper AC voltage using the selector switch.
on rear of computer chassis (some models) not switched to
correct line voltage (115V or 230V).

Power supply will not turn on because of internal power Replace the power supply.
supply fault.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Processor thermal protection activated: 1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.
A fan may be blocked or not turning.
2. Open the access panel, press the power button, and

OR see if the processor fan (or other system fan) spins. If
the fan does not spin, make sure the fan cable is
The heat sink is not properly attached to the processor. plugged onto the system board header.

3. If fan a plugged in and not spinning, replace it.
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Power LED flashes Red four times, once every second, followed by a two second pause, and the computer beeps
four times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Power failure (power supply is overloaded). 1.

4.

5.

If equipped with a voltage selector, check that the
voltage selector, located on the rear of the power supply
(some models), is set to the appropriate voltage. Proper
voltage setting depends on your region.

Open the access panel and ensure the power supply
cable is seated into the connector on the system board.

Check if a device is causing the problem by removing
ALL attached devices (such as hard drives or optical
drives and expansion cards). Power on the system. If
the system enters POST, then power off and replace
one device at a time and repeat this procedure until
failure occurs. Replace the device that is causing the
failure. Continue adding devices one at a time to ensure
all devices are functioning properly.

Replace the power supply.

Replace the system board.

The incorrect external power supply adapter is being used on The power supply adapter must be at the correct power

the All-in One or USDT. rating and use the Smart ID technology before the system
will power up. Replace the power supply adapter with the
HP-supplied power supply adapter.
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Solving Hard Drive Problems

Table 7-3 Solving Hard Drive Problems

Hard drive error occurs.

Cause

Solution

Hard disk has bad sectors or has failed.

1. In Windows 7, click Start, click Computer, and right-
click on a drive. Select Properties, and then select the
Tools tab. Under Error-checking click Check Now.

In Windows 8, on the Start screen type e, and then
select File Explorer from the list of applications. In the
left column, expand Computer, right-click on a drive,
select Properties, and then select the Tools tab. Under
Error checking click Check.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem.

Cause

Solution

Either the directory structure is bad or there is a problem with
a file.

In Windows 7, click Start, expand Computer, and right-click
on a drive. Select Properties, and then select the Tools tab.
Under Error-checking click Check Now.

In Windows 8, on the Start screen type e, and then click File
Explorer from the list of applications. In the left column,
expand Computer, right-click on a drive, select Properties,
and then select the Tools tab. Under Error checking click
Check.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 116 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced >
Power-On Options.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.
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Nonsystem disk/NTLDR missing message.

Cause

Solution

The system is trying to start from the hard drive but the hard
drive may have been damaged.

1. Perform Drive Protection System (DPS) testing in
system ROM.

System files missing or not properly installed.

1. Insert bootable media and restart the computer.

2. Boot to the windows installation media and select the
recovery option. If only a restore kit is available, then
select the File Backup Program option, and then
restore the system.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup.

Run the Computer Setup utility and enable the hard drive
entry in the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard
drive configuration.

If attempting to boot from a hard drive, ensure it is attached
to the system board dark blue SATA connector.

Bootable hard drive is not listed first in the Boot Order.

Run the Computer Setup utility and select Storage > Boot
Order and ensure the bootable hard drive is listed
immediately under the Hard Drive entry.

Computer will not boot from hard drive.

Cause

Solution

The device is attached to a SATA port that has been hidden
in Computer Setup.

1. Check SATA cable connections.

2. Run the Computer Setup utility and ensure Device
Available is selected for the device's SATA port in
Security > Device Security.

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Hard Drive's “Emulation Type” is set to “None.” (some
models)

Run the Computer Setup utility and change the “Emulation
Type” to “Hard Disk” in the device's details under Storage >
Device Configuration.

Hard drive is damaged.

Observe if the front panel Power LED is blinking RED and if
any beeps are heard. See Appendix A, POST Error
Messages on page 143 to determine possible causes for the
blinking red and beep codes.

See the Worldwide Limited Warranty for terms and
conditions.

Solving Hard Drive Problems 101



Computer seems to be locked up.

Cause Solution
Program in use has stopped responding to commands. 1. Use the task manager to close programs that do not
respond.

2.  Attempt the normal Windows “Shut Down” procedure. If
this fails, press the power button for four or more
seconds to turn off the power. To restart the computer,
press the power button again.
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Solving Media Card Reader Problems

Table 7-4 Solving Media Card Reader Problems

Media card will not work in a digital camera after formatting it in Windows.

Cause Solution
By default, Windows will format any media card with a Either format the media card in the digital camera or select
capacity greater than 32MB with the FAT32 format. Some FAT file system to format the media card in a computer with

digital cameras use the FAT (FAT16 & FAT12) format and Windows.
can not operate with a FAT32 formatted card.

A write-protected or locked error occurs when attempting to write to the media card.

Cause Solution

Media card is locked. Locking the media card is a safety If using an SD card, make sure that the lock tab located on
feature that prevents writing to and deleting from an SD/ the right of the SD card is not in the locked position. If using
Memory Stick/PRO card. a Memory Stick/PRO card, make sure that the lock tab

located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Can not write to the media card.

Cause Solution

The media card is a read-only memory (ROM) card. Check the manufacturer’'s documentation included with your
card to see if it writable. Refer to the previous section for a
list of compatible cards.

Media card is locked. Locking the media card is a safety If using an SD card, make sure that the lock tab located on
feature that prevents writing to and deleting from an SD/ the right of the SD card is not in the locked position. If using
Memory Stick/PRO card. a Memory Stick/PRO card, make sure that the lock tab

located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Unable to access data on the media card after inserting it into a slot.

Cause Solution
The media card is not inserted properly, is inserted in the Ensure that the card is inserted properly with the gold
wrong slot, or is not supported. contact on the correct side. The green LED will light if

inserted properly.
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Do not know how to remove a media card correctly.

Cause

Solution

The computer’s software is used to safely eject the card.

In Windows 7, click Start, select Computer, right-click on the
corresponding drive icon, and then select Eject. Pull the card
out of the slot.

In Windows 8, on the Start screen, type e, and then click File
Explorer from the list of applications. Expand Computer,
right-click on the corresponding drive icon, and then select
Eject. Pull the card out of the slot.

NOTE: Never remove the card when the green LED is
flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized

by the computer.

Cause

Solution

The operating system needs time to recognize the device if
the reader was just installed into the computer and you are
turning the PC on for the first time.

Wait a few seconds so that the operating system can
recognize the reader and the available ports, and then
recognize the media inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause

Solution

The inserted media card has boot capability.

1. If you do not want to boot from the media card, remove
it during boot or do not select the option to boot from the
inserted media card during the boot process.

2. During POST (Power On Self-Test), press F9 to modify
the boot menu.

3. Change the boot sequence in F10 Computer Setup.
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Solving Display Problems

If you encounter display problems, see the documentation that came with the monitor and to the
common causes and solutions listed in the following table.

Table 7-5 Solving Display Problems

Blank screen (no video).

Cause

Solution

Monitor is not turned on and the monitor light is not on.

Turn on the monitor and check that the monitor light is on.

Bad monitor.

Try a different monitor.

The cable connections are not correct.

Check the cable connection from the monitor to the computer
and to the electrical outlet.

You may have a screen blanking utility installed or energy
saver features are enabled.

Press any key or click the mouse button and type your
password (if set).

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal
scan rate as the resolution chosen.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Monitor cable is plugged into the wrong connector.

Systems may have a monitor connection on both the
motherboard or an add-in card. Try moving the monitor
connection to a different connector on the back of the
computer

Monitor settings in the computer are not compatible with the
monitor.

1. In Control Panel, select Category from the View by list,
then under Appearance and Personalization, select
Adjust screen resolution.

To access Control Panel in Windows 7, click Start, and
then select Control Panel.

To access Control Panel in Windows 8, from the Start
screen, type c, and then select Control Panel from the
list of applications.

2. Expand the Resolution box, and then use the sliding
control to reset the resolution.

Monitor is configured to use an input that is not active.

Use the monitor's on-screen menu controls to select the
input that is being driven by the system. Refer to the
monitor's user documentation for more information on the on-
screen controls and settings.

Solving Display Problems 105



Blank screen and the power LED flashes Red five times, once every second, followed by a two second pause, and
the computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Pre-video memory error.

1.  Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Blank screen and the power LED flashes Red six times, once every second, followed by a two second pause, and
the computer beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Pre-video graphics error.

For systems with a graphics card:

1. Reseat the graphics card (if applicable). Power on the
system.

2. Replace the graphics card (if applicable).
3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second pause, and
the computer beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

System board failure (ROM detected failure prior to video).

Replace the system board.

Monitor does not function properly when used with energy saver features.

Cause

Solution

Monitor without energy saver capabilities is being used with
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters.

Cause

Solution

The brightness and contrast controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly connected.

Check that the graphics cable is securely connected to the
graphics card (if applicable) or video connector and the
monitor.
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Blurry video or requested resolution cannot be set.

Cause

Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution.

Change requested resolution.

Graphics card is bad.

Replace the graphics card.

The picture is broken up, rolls, jitters, or flashes.

Cause

Solution

The monitor connections may be incomplete or the monitor
may be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the
computer.

2. In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them
apart.

3. Fluorescent lights or fans may be too close to the
monitor.

Monitor needs to be degaussed.

Degauss the monitor. Refer to the documentation that came
with the monitor for instructions.

Image is not centered.

Cause

Solution

Position may need adjustment.

Press the monitor's Menu button to access the OSD menu.
Select ImageControl/ Horizontal Position or Vertical
Position to adjust the horizontal or vertical position of the
image.

“No Connection, Check Signal Cable” displays on screen.

Cause

Solution

Monitor video cable is disconnected.

Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while
connecting the video cable.
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“Out of Range” displays on screen.

Cause Solution
Video resolution and refresh rate are set higher than what Restart the computer and enter Safe Mode. Change the
the monitor supports. settings to a supported setting then restart the computer so

that the new settings take effect.

To enter Safe Mode in Windows 7:

1.

2.

Restart the computer.

Press and hold the F8 key as your computer restarts,
before the Windows logo appears. If the Windows logo
appears, you must restart the computer and try again.

On the Advanced Boot Options screen, use the arrow
keys to highlight the safe mode option you want, and
then press Enter.

Log on to your computer with a user account that has
administrator rights.

When your computer is in safe mode, Safe Mode
displays in the corners of your monitor. To exit safe
mode, restart your computer and let Windows start
normally.

To enter Safe Mode in Windows 8:

Press the Windows logo + | to open the Settings charm.

Select Change PC Settings, select General, and then
under Advanced startup, click Restart now.

Select Troubleshoot, select Advanced options, select
Startup Settings, and then click Restart.

Use the function keys or number keys to select the safe
mode option you want.

When your computer is in safe mode, Safe Mode
displays in the corners of your monitor. To exit safe
mode, restart your computer and let Windows start
normally.

High pitched noise coming from inside a flat panel monitor.

Cause Solution

Brightness and/or contrast settings are too high. Lower brightness and/or contrast settings.
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Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to
center the picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause

Solution

Flat panel monitor’s internal digital conversion circuits may
be unable to correctly interpret the output synchronization of

the graphics card.

1. Select the monitor's Auto-Adjustment option in the
monitor’s on-screen display menu.

2. Manually synchronize the Clock and Clock Phase on-
screen display functions. To download a SoftPaq that
will assist you with the synchronization, go to the
following Web site, select the appropriate monitor, and
download either SP32347 or SP32202:
http://www.hp.com/support

Graphics card is not seated properly or is bad (some
models).

1. Reseat the graphics card.

2. Replace the graphics card.

Certain typed symbols do not appear correct.

Cause

Solution

The font you are using does not support that particular
symbol.

Use the Character Map to locate and select the appropriate
symbol. You can copy the symbol from the Character Map
into a document.

In Windows 7, click Start, select All Programs, select
Accessories, select System Tools, and then select
Character Map.

In Windows 8, on the Start screen, type ch, and then select
Character Map from the list of applications.
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Solving Audio Problems

If the computer has audio features and you encounter audio problems, see the common causes and

solutions listed in the following table.

Table 7-6 Solving Audio Problems

Sound cuts in and out.

Cause

Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.

Cause

Solution

Software volume control is turned down or muted.

Double-click the Speaker icon on the taskbar, then make
sure that Mute is not selected and use the volume slider to
adjust the volume.

NOTE: In Windows 8, the taskbar is available at the bottom
of the Desktop screen.

Audio is hidden in Computer Setup.

Enable the audio in Computer Setup: Security >
Device Security > System Audio.

The external speakers are not turned on.

Turn on the external speakers.

The audio device may be connected to the wrong jack.

Ensure that the device is connected to the correct jack on the
computer. The rear audio jack output is the green receptacle.
The speakers should be plugged into the line-out jack and

the headphones should be plugged into the headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection. The rear audio jack output is the green
receptacle.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Internal speaker is disabled in Computer Setup.

Enable the internal speaker in Computer Setup. Select
Advanced > Device Options > Internal Speaker.

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be
listed in Device Manager. Make sure the correct device is
being used.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.
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Table 7-6 Solving Audio Problems (continued)

Sound does not come out of the speaker or headphones.

Cause

Solution

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.

Cause

Solution

Headphones are plugged into the rear audio output
connector. The rear audio output connector is for powered
audio devices and is not designed for headphone use.

Plug the headphones into the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.

Cause

Solution

The hard disk may be full.

Before recording, make sure there is enough free space on
the hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.

Cause

Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the
jack or set the jack to its default value.

There is no sound or sound volume is too low.

Cause

Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be
listed in Device Manager. Make sure the correct device is
being used.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.
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Table 7-6 Solving Audio Problems (continued)

There is no sound or sound volume is too low.

Cause

Solution

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Solving Printer Problems

If you encounter printer problems, see the documentation that came with the printer and to the
common causes and solutions listed in the following table.

Table 7-7 Solving Printer Problems

Printer will not print.

Cause

Solution

Printer is not turned on and online.

Turn the printer on and make sure it is online.

The correct printer drivers for the application are not
installed.

1. Install the correct printer driver for the application.
2. Try printing using the MS-DOS command:
DIR C:\ >

[printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

To run MS-DOS commands, press the Windows key + r, type
cmd in the Open box, and then click OK.

If you are on a network, you may not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer may have failed.

Run printer self-test.

Printer will not turn on.

Cause

Solution

The cables may not be connected properly.

Reconnect all cables and check the power cord and
electrical outlet.

Printer prints garbled information.

Cause

Solution

The correct printer driver for the application is not installed.

Install the correct printer driver for the application.
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Table 7-7 Solving Printer Problems (continued)

Printer prints garbled information.

Cause Solution

The cables may not be connected properly. Reconnect all cables.

Printer memory may be overloaded. Reset the printer by turning it off for one minute, then turn it
back on.

Printer will not print.

Cause Solution

The printer may be out of paper. Check the paper tray and refill it if it is empty.
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Solving Keyboard and Mouse Problems

If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and to the common causes and solutions listed in the following table.

Table 7-8 Solving Keyboard Problems

A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement, jumpy mouse/
keyboard, or no function of mouse/keyboard and external drive.

Cause Solution

If your computer is equipped with USB 3.0 ports, connected ~ Connect the wireless keyboard USB receiver to a USB 2.0

USB 3.0 devices can interfere with the wireless keyboard port that is separated from ports with USB 3.0 devices. If you

USB receiver. still experience interference, you may have to place the
connectors farther apart using an external USB hub.

Keyboard commands and typing are not recognized by the computer.

Cause Solution

Keyboard connector is not properly connected. Shut down the computer, reconnect the keyboard to the back
of the computer, and then restart the computer.

Program in use has stopped responding to commands. Shut down your computer using the mouse and then restart
the computer.

Keyboard needs repairs. See the Worldwide Limited Warranty for terms and
conditions.
Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep date,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key is on. Press the Num Lock key. The Num Lock light should be off if
you want to use the arrow keys on the keypad. You can
disable or enable the Num Lock key in Computer Setup at
Advanced > Device Options.
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Table 7-9 Solving Mouse Problems

Mouse does not respond to movement or is too slow.

Cause

Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.
Windows 7:

1. Press the Ctrl and Esc keys at the same time (or press
the Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then
press Enter.

3.  After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Windows 8:
1. Press the Windows logo + | to open the Settings charm.

2. Use the arrow keys to select Power, and then press
Enter.

3. Use the arrow keys to select Shut Down, and then
press Enter.

4.  After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Program in use has stopped responding to commands.

Shut down the computer using the keyboard then restart the
computer.

Mouse may need cleaning.

Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair.

See the Worldwide Limited Warranty for terms and
conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause

Solution

Mouse roller ball or the rotating encoder shafts that make
contact with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and
clean the internal components with a mouse cleaning kit
available from most computer stores.
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Solving Hardware Installation Problems

You may need to reconfigure the computer when you add or remove hardware, such as an additional
drive or expansion card. If you install a plug and play device, Windows automatically recognizes the
device and configures the computer. If you install a non-plug and play device, you must reconfigure
the computer after completing installation of the new hardware. In Windows, use the Add Hardware
Wizard and follow the instructions that appear on the screen.

To open the Add Hardware Wizard, open a Command Prompt and open hdwwiz.exe.

AWARNING! When the computer is plugged into an AC power source, voltage is always applied to

the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to

cool before touching.

Table 7-10 Solving Hardware Installation Problems

A new device is not recognized as part of the system.

Cause

Solution

Device is not seated or connected properly.

Ensure that the device is properly and securely connected
and that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables
are unplugged.

Ensure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on.

Turn off the computer, turn on the external device, then turn
on the computer to integrate the device with the computer
system.

When the system advised you of changes to the
configuration, you did not accept them.

Reboot the computer and follow the instructions for
accepting the changes.

A plug and play board may not automatically configure when

added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic
settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use
Computer Setup to reconfigure or disable devices to resolve
the resource conflict.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > USB Security.
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Computer will not start.

Cause

Solution

Wrong memory modules were used in the upgrade or
memory modules were installed in the wrong location.

1. Review the documentation that came with the system to
determine if you are using the correct memory modules
and to verify the proper installation.

NOTE: DIMM1 or XMM1 must always be installed. On
all computers except the USDT, DIMM1 must be
installed before DIMMZ2, and DIMM3 must be installed
before DIMM4.

2. Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for
specific problems.

3.  If you still cannot resolve the issue, contact Customer
Support.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Memory is installed incorrectly or is bad.

CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM module.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

NOTE: DIMM1 or XMM1 must always be installed. On
all computers except the USDT, DIMM1 must be
installed before DIMM2, and DIMM3 must be installed
before DIMM4

3. Replace third-party memory with HP memory.

4. Replace the system board.

Power LED flashes Red six times, once every second, followed by a two second pause, and the computer beeps six
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Graphics card (some models) is not seated properly or is
bad, or system board is bad.

For systems with a graphics card:

1.

2

3.

Reseat the graphics card. Power on the system.
Replace the graphics card.

Replace the system board.

For systems with integrated graphics, replace the system
board.
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Power LED flashes Red ten times, once every second, followed by a two second pause, and the computer beeps ten
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Bad option card. 1.

Check each option card by removing the cards one at
time (if multiple cards), then power on the system to see
if fault goes away.

Once bad card is identified, remove and replace bad
option card.

Replace the system board.

Solving Network Problems

Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.

Table 7-11 Solving Network Problems

Wake-on-LAN feature is not functioning.

Cause Solution

S5 Maximum Power Saving feature is enabled. Disable the S5 Maximum Power Saving option in Computer
Setup. Select Power > Hardware Power Management > S5
Maximum Power Savings.

S5 Wake on LAN is disabled (some models). Enable the S5 Wake on LAN option in Computer Setup.
Select Advanced > Device Options > S5 Wake on LAN.

Wake-on-LAN is not enabled. To enable Wake-on-LAN in Windows 7:

1.

Select Start > Control Panel > Network and Sharing
Center.

Under Tasks, select Manage network connections.
Click Local Area Connection.

Click the Properties button.

Click the Configure button.

Click the Power Management tab, then select Allow
this device to wake the computer.

To enable Wake-on-LAN in Windows 8:

1.

From the Start screen, type c, and then select Control
Panel from the list of applications.

Select Network and Sharing Center, and then click the
Ethernet link next to the connection.

Click the Properties button.
Click the Configure button.

Click the Power Management tab, then enable the
appropriate Wake-on LAN option.
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Network driver does not detect network controller.

Cause

Solution

Network controller is disabled.

1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
using Device Manager.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

To access Device Manager in Windows 8, from the
Start screen, type c, select Control Panel from the list
of applications, and then select Device Manager.

Incorrect network driver.

Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer's Web
site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause

Solution

No active network is detected.

Check cabling and network equipment for proper connection.

Network controller is not set up properly.

Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Network controller is disabled.

1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
using Device Manager.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

To access Device Manager in Windows 8, from the
Start screen, type c, select Control Panel from the list
of applications, and then select Device Manager.

Network driver is not properly loaded.

Reinstall network drivers.

System cannot autosense the network.

Disable auto-sensing capabilities and force the system into
the correct operating mode.
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Diagnostics reports a failure.

Cause

Solution

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector.

Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other
end of the cable.

Ensure that the cable and device at the other end are
operating correctly.

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller is defective.

Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause

Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer.

Select the Network and Sharing Center icon in the Control
Panel and configure the network controller.

To access Control Panel in Windows 7, click Start, and then
select Control Panel.

To access Control Panel in Windows 8, from the Start
screen, type c, and then select Control Panel.

Network controller stopped working when an expansion board was added to the computer.

Cause

Solution

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller requires drivers.

Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

Network controller stops working without apparent cause.

Cause

Solution

The files containing the network drivers are corrupted.

Reinstall the network drivers using the Recovery Disc Set in
Windows 7 or Windows recovery tools in Windows 8.

If necessary, download the softpaq from the web (from a
different computer).
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Table 7-11 Solving Network Problems (continued)

Network controller stops working without apparent cause.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective. Contact an authorized service provider.

New network card will not boot.

Cause Solution
New network card may be defective or may not meet Install a working, industry-standard NIC, or change the boot
industry-standard specifications. sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Solving Memory Problems

If you encounter memory problems, some common causes and solutions are listed in the following
table.

/\ CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending
on the Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you
must unplug the computer power cord before attempting to reseat, install, or remove a memory
module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC
memory. Otherwise, the computer will not boot the operating system.

E"%NOTE: The memory count will be affected by configurations with the Management Engine (ME)
enabled. The ME uses 8MB of system memory in single channel mode or 16MB of memory in dual-
channel mode to download, decompress, and execute the ME firmware for Out-of-Band (OOB), third-
party data storage, and other management functions.
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Table 7-12 Solving Memory Problems

System will not boot or does not function properly after installing additional memory modules.

Cause

Solution

A memory module is not installed in the DIMM1 or XMM1
socket.

Ensure that a memory module is installed in the DIMM1 or
XMM1 socket on the system board. This socket must be
populated with a memory module.

Memory module is not the correct type or speed grade for
the system or the new memory module is not seated
properly.

Replace module with the correct industry-standard device for
the computer. On some models, ECC and non-ECC memory
modules cannot be mixed.

Out of memory error.

Cause

Solution

You have run out of memory to run the application.

Check the application documentation to determine the
memory requirements.

Memory count during POST is wrong.

Cause

Solution

The memory modules may not be installed correctly.

Check that the memory modules have been installed
correctly and that proper modules are used.

Integrated graphics may use system memory.

No action required.

Insufficient memory error during operation.

Cause

Solution

Too many Terminate and Stay Resident programs (TSRs)
are installed.

Delete any TSRs that you do not need.

You have run out of memory for the application.

Check the memory requirements for the application or add
more memory to the computer.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Memory is installed incorrectly or is bad.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Solving Processor Problems

If you encounter processor problems, common causes and solutions are listed in the following table.

Table 7-13 Solving Processor Problems

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure the airflow to the computer is not blocked.

2. Make sure the fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Power LED flashes Red three times, once every second, followed by a two second pause.

Cause Solution

Processor is not seated properly or not installed. 1. Check to see that the processor is present.

2. Reseat the processor.

Power LED flashes Red eleven times, once every second, followed by a two second pause.

Cause Solution

The current processor does not support a feature previously 1. Install a TXT (Trusted Execution Technology) capable
enabled on this system. processor.

2. Disable TXT in the Computer Setup (F10) utility.

3. Reinstall the original processor.

Solving CD-ROM and DVD Problems

If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the
following table or to the documentation that came with the optional device.

Table 7-14 Solving CD-ROM and DVD Problems

System will not boot from CD-ROM or DVD drive.

Cause Solution

The device is attached to a SATA port that has been hidden  Run the Computer Setup utility and ensure Device Available

in the Computer Setup utility. is selected for the device's SATA port in Security > Device
Security.

Removable Media Boot is disabled in the Computer Setup Run the Computer Setup utility and enable booting to

utility. removable media in Storage > Storage Options. Ensure

CD-ROM is enabled in Storage > Boot Order.
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Table 7-14 Solving CD-ROM and DVD Problems (continued)

System will not boot from CD-ROM or DVD drive.

Cause

Solution

Network Boot is enabled in Computer Setup.

Run the Computer Setup utility and disable Network Boot in
Security > Network Boot.

Non-bootable CD in drive.

Try a bootable CD in the drive.

Boot order not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 116 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced >
Power-On Options.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

CD-ROM or DVD devices are not detected or driver is not loaded.

Cause

Solution

Drive is not connected properly or not properly configured.

See the documentation that came with the optional device.

Movie will not play in the DVD drive.

Cause

Solution

Movie may be regionalized for a different country.

See the documentation that came with the DVD drive.

Decoder software is not installed.

Install decoder software.

Damaged media.

Replace media.

Movie rating locked out by parental lock.

Use DVD software to remove parental lock.

Media installed upside down.

Reinstall media.
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Cannot eject compact disc (tray-load unit).

Cause Solution

Disc not properly seated in the drive. Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray
out from the drive until the tray is fully extended, then remove
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause Solution
Media is corrupt. Try different media to confirm whether media is valid.
Media has been inserted upside down. Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to Wait at least 30 seconds to let the DVD-ROM drive
determine the type of media played, such as audio or video.  determine the type of media being played. If the disc still
does not start, read the other solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive. 1. Use Device Manager to remove or uninstall the device.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

To access Device Manager in Windows 8, from the
Start screen, type c, select Control Panel from the list
of applications, and then select Device Manager.

2. Restart the computer and let Windows detect the CD or

DVD driver.
Recording or copying CDs is difficult or impossible.
Cause Solution
Wrong or poor quality media type. 1. Try using a slower speed when recording.

2.  Verify that you are using the correct media for the drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.

Solving USB Flash Drive Problems

If you encounter USB flash drive problems, common causes and solutions are listed in the following
table.
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Table 7-15 Solving USB Flash Drive Problems

USB flash drive is not seen as a drive letter in Windows.

Cause

Solution

The drive letter after the last physical drive is not available.

Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause

Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and enable USB ports in
Security > USB Security.

The device was not properly seated before power-up.

Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause

Solution

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
USB is enabled in Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.

Cause

Solution

Flash drive is bootable.

Install the flash drive only after the operating system boots.

Flash drive is defective.

Try a different flash drive.
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Solving Front Panel Component Problems

If you encounter problems with devices connected to the front panel, refer to the common causes and

solutions listed in the following table.

A USB device, headphone, or microphone is not recognized by the computer.

Cause

Solution

Device is not properly connected.

1. Turn off the computer.

2. Reconnect the device to the front of the computer and
restart the computer.

The device does not have power.

If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not installed.

1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work.

1. If possible, replace the cable.

2. Restart the computer.

The device is not working.

1. Replace the device.

2. Restart the computer.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that the USB
ports are set to Enabled in Security > USB Security.

Solving Internet Access Problems

If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.

Unable to connect to the Internet.

Cause

Solution

Internet Service Provider (ISP) account is not set up
properly.

Verify Internet settings or contact your ISP for assistance.

Web browser is not set up properly.

Verify that the Web browser is installed and set up to work
with your ISP.

Cable/DSL modem is not plugged in.

Plug in cable/DSL modem. You should see a “power” LED
light on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted
due to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected.

Connect the CAT5 UTP cable between the cable modem
and the computers’s RJ-45 connector. (If the connection is
good, the “PC” LED light on the front of the cable/DSL
modem will be on.)
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Unable to connect to the Internet.

Cause Solution

IP address is not configured properly. Contact your ISP for the correct IP address.
Cookies are corrupted. (A “cookie” is a small piece of Windows 7:

information that a Web server can store temporarily with the

Web browser. This is useful for having the browser 1. Select Start > Control Panel.
remember some specific information that the Web server can

later retrieve.) 2. Click Internet Options.

3. Inthe Browsing history section on the General tab,
click the Delete button.

4. Select the Cookies check box and click the Delete
button.

Windows 8:

1. From the Start screen, type c, and then select Control
Panel from the list of applications..

2. Click Internet Options.

3. Inthe Browsing history section on the General tab,
click the Delete button.

4. Select the Cookies check box and click the Delete
button.

Cannot automatically launch Internet programs.

Cause Solution

You must log on to your ISP before some programs will start. Log on to your ISP and launch the desired program.

128 Chapter 7 Troubleshooting Without Diagnostics



Solving Software Problems

Most software problems occur as a result of the following:

e The application was not installed or configured correctly.

e There is insufficient memory available to run the application.

e There is a conflict between applications.

e Be sure that all the needed device drivers have been installed.

e If you have installed an operating system other than the factory-installed operating system,
check to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Computer will not continue and the HP logo does not display.

Cause Solution

ROM issue - POST error has occurred. Observe the beeps and LED lights on the front of the
computer. See Appendix A, POST Error Messages
on page 143 to determine possible causes.

See the Worldwide Limited Warranty for terms and
conditions.
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Computer will not continue after HP logo screen displays.

Cause Solution

System files may be damaged. In Windows 7, use recovery media to scan hard drive for
errors, or use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly. Windows
Startup Repair is one of the recovery tools in the System
Recovery Options menu. You can also create a system
repair disc that contains the System Recovery Options
menu. If the problem is severe enough that Startup Repair
doesn't start on its own and you can't access the System
Recovery Options menu on your computer's hard disk, you
can get to the menu and start Startup Repair by using the
Windows installation disc or a system repair disc that you
created earlier.

In Windows 8, use Automatic Repair to fix problems that
might prevent Windows from starting correctly.

To access Automatic Repair:
1. Press the Windows logo + | to open the Settings charm.

2. Select Change PC Settings, select General, and then
under Advanced startup, click Restart now.

3. Select Troubleshoot, select Advanced options, and
then select Automatic Repair.

Windows starts Automatic Repair.

4. Select the account to use to begin Automatic Repair,
and type the password for the account.

Windows diagnoses the computer and attempts the

repair it.
“lllegal Operation has Occurred” error message is displayed.
Cause Solution
Software being used is not Microsoft-certified for your Verify that the software is certified by Microsoft for your
version of Windows. version of Windows (see program packaging for this
information).
Configuration files are corrupt. If possible, save all data, close all programs, and restart the
computer.
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Contacting Customer Support

For help and service, contact an authorized reseller or dealer. To locate a reseller or dealer near you,
visit http://www.hp.com.

E‘%NOTE: If you take the computer to an authorized reseller, dealer, or service provider for service,
remember to provide the setup and power-on passwords if they are set.

Refer to the number listed in the warranty or in the Support Telephone Numbers guide for technical
assistance.
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8 HP PC Hardware Diagnostics

Use the UEFI-based hardware diagnostic solution that HP includes on all products to diagnose
hardware issues. You can use this tool even if the computer will not boot to the operating system.
This tool also works with components not diagnosed in HPSA.

Why run HP PC Hardware Diagnostics

The HP PC Hardware Diagnostic tools simplify the process of diagnosing hardware issues and
expedite the support process when issues are found. The tools save time by pinpointing the
component that needs to be replaced.

e Isolate true hardware failures: The diagnostics run outside of the operating system so they
effectively isolate hardware failures from issues that may be caused by the operating system or
other software components.

e Failure ID: When a failure is detected that requires hardware replacement, a 24-digit Failure ID
is generated. This ID can then be provided to the call agent, who will either schedule support or
provide replacement parts.
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How to access and run HP PC Hardware Diagnostics

You can run the diagnostics from one of three places, depending on your preference and the health
of the computer.

1. Turn on the computer and press Esc repeatedly until the BIOS Boot Menu appears.
2. Press F2 or select Diagnostics (F2).
Pressing F2 signals the system to search for the diagnostics in the following locations:

a. A connected USB drive (to download the diagnostics tools to a USB drive, see the
instructions in Downloading HP PC Hardware Diagnostics to a USB device on page 134)

b. The hard disk drive

c. A core set of diagnostics in the BIOS (for memory and hard disk drive) that are accessible
only if the USB or hard disk drive versions are not detected
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Downloading HP PC Hardware Diagnostics to a USB
device

1. Go to http://www.hp.com.

Click the Support & Drivers link.

Select the Drivers & Software tab.

2
3
4. Enter the product name in the text box and click Search.
5. Select your specific computer model.

6. Select your operating system.

7

In the Diagnostic section, click the HP UEFI Support Environment link. This link provides
additional information.

_Or-

Click the Download button and select Run. The download includes instructions (in English) on
how to install the tools on the USB device.

E/?’NOTE: HP diagnostic solutions are developed to test components typically included on HP
products. They may not diagnose all third-party accessories that can be added to the system.
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9 Backup and Recovery

Restoring and recovering in Windows 7

To protect from loss or damage, back up your personal data files. Refer to the operating system or
backup utility documentation for instructions on making backup copies of your data files.

To protect the software from loss or damage, keep a backup copy of all system software,
applications, and related files stored on the hard drive.

If you cannot create system recovery CDs or DVDs, you can order a recovery disk set from support.
To obtain the support telephone number for your region, see http://www.hp.com/support/contactHP.

System Restore

If you have a problem that might be due to software that you installed on your computer, use System
Restore to return the computer to a previous restore point. You can also set restore points manually.

E’%NOTE: Always use this System Restore procedure before you use the System Recovery feature.

=¥ NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

To start System Restore:
1. Close all open programs.
2.  Click the Start button, right-click Computer, and then click Properties.

3. Click System protection, System Restore, click Next, and then follow the on-screen
instructions.

To add restore points manually:
1. Close all open programs.

2. Click the Start button, right-click Computer, click Properties, and then click System
protection.

3. Under Protection Settings, select the disk for which you want to create a restore point.

4. Click Create, and then follow the on-screen instructions.

System Recovery

/\ WARNING! This procedure will delete all user information. To prevent loss of information, be sure
to back up all user information so you can restore it after recovery.
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System Recovery completely erases and reformats the hard disk drive, deleting all data files that you
have created, and then reinstalls the operating system, programs, and drivers. However, you must
reinstall any software that was not installed on the computer at the factory. This includes software that
came on media included in the computer accessory box, and any software programs you installed
after purchase.

@NOTE: Always use the System Restore procedure before you use the System Recovery program.
See System Restore on page 135.

=¥ NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

You must choose one of the following methods to perform a System Recovery:

Recovery image — Run System Recovery from a recovery image stored on your hard disk drive.
The recovery image is a file that contains a copy of the original factory-shipped software. To
perform a System Recovery from a recovery image, see System Recovery when Windows is
responding on page 136 or System Recovery when Windows is not responding on page 137.

Recovery media — Run System Recovery from recovery media that you have created from files
stored on your hard disk drive or purchased separately. To create recovery media, see System
recovery using recovery media on page 137.

System Recovery when Windows is responding

/\ CAUTION: System Recovery deletes all data and programs you created or installed. Before you
begin, back up any important data to a CD or DVD or to a USB flash drive.

=¥ NOTE: In some cases, you must use recovery media for this procedure. To create this media, follow
the instructions in Creating recovery media on page 138.

If the computer is working and Windows 7 is responding, use these steps to perform a System
Recovery.

1.

2
3.
4

Turn off the computer.
Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.
Turn on the computer.

When Windows has loaded, click the Start button, click All Programs, click Security and
Protection, click Recovery Manager, and then click Recovery Manager. If prompted, click Yes
to allow the program to continue.

Under | need help immediately, click System Recovery.

Select Yes, and then click Next. Your computer restarts.

E‘%NOTE: If your system does not detect a recovery partition, it prompts you to insert recovery

media that you have created. Insert the first disc or the USB flash drive, select Yes, and then
click Next to restart the computer. If you are using discs, insert the next disc when prompted.

When the computer restarts, you will see the Recovery Manager welcome screen again. Under |
need help immediately, click System Recovery. If you are prompted to back up your files, and
you have not done so, select Back up your files first (recommended), and then click Next.
Otherwise, select Recover without backing up your files, and then click Next.
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8. System Recovery begins. After System Recovery is complete, click Finish to restart the
computer.

9.  When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System Recovery when Windows is not responding

/\ CAUTION: System Recovery deletes all data and programs you created or installed.

If Windows is not responding, but the computer is working, follow these steps to perform a System
Recovery.

1. Turn off the computer. If necessary, press and hold the power button until the computer turns off.
2. Disconnect all peripheral devices from the computer, except the monitor, keyboard, and mouse.

3. Press the power button to turn on the computer.
4

As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the
Windows is Loading Files... message appears on the screen.

o

Under | need help immediately, click System Recovery.

6. If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing up
your files, and then click Next.

7. System Recovery begins. After System Recovery is complete, click Finish to restart the
computer.

8. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System recovery using recovery media

You should create a set of recovery media, either a set of DVDs or a USB flash drive, from the
recovery image stored on your hard disk drive. This image contains the operating system and
software program files that were originally installed on your computer at the factory. You can create
only one set of recovery media for your computer, and the media can be used only with this
computer. Store the recovery media in a safe place.

=»NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

e To create recovery discs, your computer must have a DVD writer, and you must use only high-
quality blank DVD+R or DVD-R discs.

@NOTE: You cannot use DVD+RW, DVD-RW, DVD+RW DL, DVD-RW DL, DVD+R DL, or DVD-
R DL discs to create recovery discs.

e You have the option of creating a recovery USB flash drive instead, using a high-quality USB
drive.
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e If you are creating recovery discs, be sure to use high-quality discs. It is normal for the system to
reject defective discs. You will be prompted to insert a new blank disc to try again.

e The number of discs in the recovery-disc set depends on your computer model (typically 3 to 6
DVDs). The Recovery Media Creation program tells you the specific number of blank discs
needed to make the set. If you are using a USB flash drive, the program will tell you the size of
the drive required to store all the data (minimum of 8 GB).

E‘%NOTE: The process of creating recovery media is lengthy. You can quit the process at any
time. The next time you initiate the process, it resumes where it left off.

Creating recovery media
To create recovery discs:
1. Close all open programs.

2. Click the Start button, click All Programs, click Security and Protection, and then click HP
Recovery Media Creation. If prompted, click Yes to allow the program to continue.

3. Click Create recovery media using blank DVD(s), and then click Next.

4. Follow the on-screen instructions. Label each disc as you make it (for example, Recovery 1,
Recovery 2), and then store the discs in a secure place.

To create a recovery USB flash drive:

@NOTE: You must use a flash drive with a capacity of at least 8 GB.

1. Close all open programs.
2. Insert the USB flash drive into a USB port on the computer.

3. Click the Start button, click All Programs, click Security and Protection, and then click
Recovery Media Creation.

4. Click Create recovery media with a USB flash drive, and then click Next.

5. Select the USB flash drive from the list of media. The program will let you know how much
storage is required to create the recovery drive. If the USB flash drive does not have enough
storage capacity, it will appear grayed out, and you must replace it with a larger USB flash drive.
Click Next.

E’%NOTE: Recovery Media Creation formats the flash drive, deleting any files on it.

6. Follow the on-screen instructions. When the process is complete, label the USB flash drive and
store it in a secure place.

@NOTE: Do not use media cards for creating recovery media. The system may not be able to boot up
from a media card and you may not be able to run system recovery.
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Using recovery media

ACAUTION: System Recovery deletes all data and programs you have created or installed. Back up
any important data to a CD or DVD or to a USB flash drive.

To create recovery media, see System recovery using recovery media on page 137.

To perform a System Recovery using recovery media:

1. If using a set of DVDs, insert the first recovery disc into the DVD drive tray, and close the tray. If
you are using a recovery USB flash drive, insert it into a USB port.

2. If the computer is not responding, press and hold the power button for approximately 5 seconds
or until the computer turns off.

or
Click the Start button, and then click Shut Down.

3. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

4. Press the power button to turn on the computer.

5. Press Esc as the computer is powering on to see the startup menu. Use the arrow keys to select
the boot menu and press Enter. Use the arrow keys to select the location where the recovery
media is inserted (USB or DVD). Press Enter to boot from that device.

6. If Recovery Manager asks if you want to run System Recovery from Media or Hard Drive, select
Media. On the Welcome screen, under | need help immediately, click Factory Reset.

7. If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing up
your files, and then click Next.

8. If you are prompted to insert the next recovery disc, do so.

9.  When Recovery Manager is finished, remove the recovery disc or the recovery USB flash drive
from the system.

10. Click Finish to restart the computer.
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Backup and recovery in Windows 8

To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive, create system repair media, or create system restore points. In case
of system failure, you can use the backup files to restore the contents of your computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed
options.

=¥ NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. From the Start screen, type h, and then select Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them
for later use.

=¥ NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information. From the Start screen, type h, and then select Help and Support.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system
repair media and your initial backup immediately after initial system setup. As you add new software
and data files, you should continue to back up your system on a regular basis to maintain a
reasonably current backup. The system repair media is used to start up (boot) the computer and
repair the operating system in case of system instability or failure. Your initial and subsequent
backups allow you to restore your data and settings if a failure occurs.

Type backup on the Start screen, click Settings, and then select Save backup copies of your files
with File History.

You can back up your information to an optional external hard drive, or a network drive.
Note the following when backing up:

e  Store personal files in the Documents library, and back it up regularly.

e  Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore:

@NOTE: Be sure that the computer is connected to AC power before you start the backup process.

@NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. From the Start screen, type backup, click Settings, and then select from the list of displayed
options.

2. Follow the on-screen instructions to set up your backup, create a system image, or create
system repair media.
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Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Automatic Repair to fix problems that
might prevent Windows from starting correctly.

e 11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

E}fNOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created, you must purchase Windows 8 operating system media to reboot the
computer and repair the operating system. For additional information, see Using Windows 8 operating
system media (purchased separately) on page 142.

Using the Windows recovery tools
To recover information you previously backed up:
A From the Start screen, type h, and then select Help and Support.

To recover your information using Automatic Repair, follow these steps:

ACAUTION: Some Automatic Repair options will completely erase and reformat the hard drive. For
additional information go to Help and Support. From the Start screen, type h, and then select Help
and Support.

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition and the Windows partition:
From the Start screen, type e, and then click Windows Explorer.
—or—

From the Start screen, type c, and then select Computer.

@NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system media and the
Driver Recovery media (both purchased separately). For additional information, see Using
Windows 8 operating system media (purchased separately) on page 142.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer after
Windows has loaded, and then press and hold Shift while clicking Restart.

@NOTE: If the computer fails to boot to Windows after several attempts, the system will boot to
the Windows Recovery Environment by default.

4. Select Troubleshoot, select Advanced Options, and then select Automatic Repair.

5. Follow the on-screen instructions.

=¥ NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support. From the Start screen, type h, and then select Help and
Support.
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Using f11 recovery tools

/\ CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that
were installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type C,
and then select Computer.

E%?NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media, and the Driver Recovery media (both
purchased separately). For additional information, see Using Windows 8 operating system
media (purchased separately) on page 142.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the
company logo is displayed. The computer Startup Menu displays.

4. Press f11 to select the System Recovery option.

5. Follow the on-screen instructions.

Using Windows 8 operating system media (purchased separately)

To order Windows 8 operating system media, go to http://www.hp.com/support, select your country or
region, and follow the on-screen instructions. You can also order the media by calling support.

/\ CAUTION: Using Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on
the computer are permanently removed. When reformatting is complete, the recovery process helps
you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using Windows 8 operating system media:

@NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then follow the instructions provided with the Windows 8 operating
system media to install the operating system.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the repair is completed:

1. Remove the Windows 8 operating system media, and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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10

POST Error Messages

This appendix lists the error codes, error messages, and the various indicator light and audible
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the
probable source of the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count
and non-error text messages. If a POST error occurs, the screen will display the error message. To
manually switch to the POST Messages Enabled mode during POST, press any key (except F10,
F11, or F12). The default mode is POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

143



POST Numeric Codes and Text Messages

This section covers those POST errors that have numeric codes associated with them. The section
also includes some text messages that may be encountered during POST.

E/?’NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table 10-1 Numeric Codes and Text Messages

Control panel message

Description

Recommended action

ERROR: No boot disk has been detected or
the disk has failed.

The computer cannot read the boot sector
of the boot disk.

1. Check drive data and power cables.

2. Use F10 Setup to make sure the first
boot device is set to drive C or the
primary hard drive.

3. The drive has failed due to mechanical
or virus corruption. Replace the drive.

Keyboard Error

Keyboard failure.

1. Reconnect keyboard with computer
turned off.

2.  Check connector for bent or missing
pins.

3.  Ensure that none of the keys are
depressed.

4. Replace keyboard.

5. Replace the system board.

511-CPU Fan not Detected

CPU fan is not connected or may have
malfunctioned.

1. Reseat CPU fan.
2. Reseat fan cable.

3. Replace CPU fan.

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard
drives have a hard drive firmware patch that
will fix an erroneous error message.)

1. Determine if hard drive is giving correct
error message. Enter Computer Setup
and run the Drive Protection System
test under Storage > DPS Self-test.

2. Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3. Back up contents and replace hard
drive.

Unsupported CPU

Recently installed processor is not
supported by the system.

Install a processor supported by your
system.

Time & Date Not Set

Invalid time or date in configuration
memory.

RTC (real-time clock) battery may need to
be replaced.

CMOS jumper may not be properly
installed.

Reset the date and time under Control
Panel (Computer Setup can also be used).
If the problem persists, replace the RTC
battery.

Check for proper placement of the CMOS
jumper if applicable.
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Interpreting POST Diagnostic Front Panel LEDs

This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.

/\ WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

E’%NOTE: If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of
the computer and refer to the following table to determine the front panel LED codes.

Recommended actions in the following table are listed in the order in which they should be
performed.

Not all diagnostic lights and audible codes are available on all models.

Table 10-2 Diagnostic Front Panel LEDs and Audible Codes

Activity Blink Possible Cause Recommended Action

S

White Power LED flashes 5
five times, once every

second, followed by a two
second pause. Beeps stop
after fifth iteration but

LEDs continue until 1.
problem is solved.

Pre-video memory error. CAUTION: To avoid damage to the DIMMs or the

system board, you must unplug the computer power
cord before attempting to reseat, install, or remove a
DIMM module.

Reseat DIMMs.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

White Power LED flashes 6
six times, once every

Pre-video graphics error. For systems with a graphics card:

second, followed by a two 1. Reseat the graphics card.
second pause. Beeps stop ]
after fifth iteration but 2. Replace the graphics card.

LEDs continue until

problem is solved. 3. Replace the system board.

For systems with integrated graphics, replace the
system board.

White Power LED flashes
seven times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but
LEDs continue until
problem is solved.

System board failure (ROM
detected failure prior to
video).

Replace the system board.

White Power LED flashes
eight times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but
LEDs continue until
problem is solved.

Invalid ROM based on bad
checksum.

1. Reflash the system ROM with the latest BIOS
image.

2. Replace the system board.
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11 Password Security and Resetting
CMOS

This computer supports security password features, which can be established through the Computer
Setup Utilities menu.

This computer supports two security password features that are established through the Computer
Setup Utilities menu: setup password and power-on password. When you establish only a setup
password, any user can access all the information on the computer except Computer Setup. When
you establish only a power-on password, the power-on password is required to access Computer
Setup and any other information on the computer. When you establish both passwords, only the
setup password will give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to
the information on the computer by resetting the password jumper.

ACAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to
back up the computer CMOS settings before resetting them in case they are needed later. Back up is
easily done through Computer Setup. See Computer Setup (F10) Utility on page 10 for information.
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Establishing a Setup or Power-on Password

To establish the power-on or setup password features, complete the following steps:
1. Turn on or restart the computer.

2. As soon as the computer turns on, press the Esc key while “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

3. Press the F10 key to enter Computer Setup.
4. To establish Setup password, select Security > Setup Password and follow the instructions.

To establish a Power-On password, select Security > Power-On Password and follow the
instructions on the screen

5. Before exiting, click File > Save Changes and Exit.
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Resetting the Setup and Power-on Password

To disable the power-on or setup password features, or to clear the power-on or setup passwords,
complete the following steps:

1.

Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

With the power cord disconnected, press the power button again to drain the system of any
residual power.

/\ WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be

sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

ACAUTION: When the computer is plugged in, the power supply always has voltage applied to

3.
4,

the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Regulatory, Safety and Environmental Notices guide
for more information.

Remove the access panel.

Locate the header and jumper labeled PW.

E’%NOTE: The password jumper is blue so that it can be easily identified. For assistance locating

© o N o o

148 Chapter 11

the password jumper and other system board components, see the lllustrated Parts & Service
Map (IPSM). The IPSM can be downloaded from http://www.hp.com/support.

Remove the jumper.

Replace the jumper.

Replace the access panel.
Reconnect the external equipment.

Plug in the computer and turn on power. Allow the operating system to start. This clears the
current passwords and disables the password features.

Establish the new passwords in Computer Setup. See Computer Setup (F10) Utility on page 10
for information.
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Resetting CMOS

The computer’s configuration memory (CMOS) stores information about the computer’s configuration.

/\ CAUTION: Removing and replacing the CMOS jumper will reset CMOS values to factory defaults. It
is important to back up the computer CMOS settings before resetting them in case they are needed
later. Back up is easily done through Computer Setup. See Computer Setup (F10) Utility on page 10
for information.

To reset CMOS, complete the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

/\ WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

ACAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Regulatory, Safety and Environmental Notices guide
for more information.

3.  Remove the access panel.

4. Locate the header and jumper labeled CMOS.

=¥ NOTE: The password jumper is blue so that it can be easily identified. For assistance locating
the password jumper and other system board components, see the lllustrated Parts & Service
Map (IPSM). The IPSM can be downloaded from http://www.hp.com/support.

Remove the jumper and place it on pins 1 and 2.

5
6. Wait for three seconds, and then replace the jumper to its original position (pins 2 and 3).
7. Replace the access panel.

8

Reconnect the external equipment.

©

Plug in the computer and turn on power. Allow the operating system to start.

=¥ NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you that
configuration changes have occurred. Use Computer Setup to reset any special system setups along
with the date and time.
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A Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch
feature on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts
AC. Power supplies on those computers that do not have external power switches are equipped with
internal switches that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where
you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use
the computer.

General Requirements

The requirements listed below are applicable to all countries:

1.  The power cord must be approved by an acceptable accredited agency responsible for
evaluation in the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a
nominal voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm, or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point
where the cord exits from the product.

AWARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements

For use in Japan, use only the power cord received with this product.

/\ CAUTION: Do not use the power cord received with this product on any other products.
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Country-Specific Requirements

Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency Country Accrediting Agency
Australia (1) EANSW Italy (1) IMQ

Austria (1) OVE Japan (3) METI

Belgium (1) CEBC Norway (1) NEMKO

Canada (2) CSA Sweden (1) SEMKO

Denmark (1) DEMKO Switzerland (1) SEV

Finland (1) SETI United Kingdom (1) BSI

France (1) UTE United States (2) UL

Germany (1) VDE

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm, conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it
will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm, conductor size. Wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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B Specifications

All-in One Models

Table B-1 Specifications

Desktop Dimensions

Height 16.00 in 40.6 cm
Width 20.00in 50.7 cm
Depth 8.66 in 22.0 cm
Approximate Weight

15.36 Ib 6.97 kg
With stand

12.63 1b 5.73 kg
Without stand
Display
Type TN (Twisted Nematic) LED Backlit LCD
Viewable image area 442.8(H) x 249.075(V) [mm]
Resolution 1600x900
Contrast ratio 1000:1 (typical)
Image brightness 250 nits (typical)
Viewing angle (typical) 85°/85°/80°/80° (L/R/U/D)
Pixel pitch 0.27675(H) x 0.27675(W) [mm]
Backlight lamp life (to half brightness) 30,000 hours minimum
Color gamut (typical) 72%
Anti-glare Yes
Temperature Range
Operating 41°to 95°F 5° to 35°C
Nonoperating -22° to 149°F -30° to 65°C
Relative Humidity (noncondensing)
Operating 15-80% at 79°F 15-80% at 26°C

152 Appendix B Specifications



Table B-1 Specifications (continued)

Maximum Altitude (unpressurized)

Operating 0-6,500 ft 0-2000m
Nonoperating 0- 15,000 ft 4,572 m
Power Supply

Rated Voltage Range 100-240 V

Rated Line Frequency 50-60 Hz

Max Operating Power 150 W
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front panel problems 127

G
general problems 94
grounding methods 28

H
hard drive
proper handling 32
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opening the computer 33
operating guidelines 29
optical drive
removing 40
optical drive connector
removing 80
optical drive problems 123
overheating, prevention 29

P
password
clearing 146
power-on 146
setup 146
POST error messages 143
power cord set requirements
country specific 151
power problems 98
power supply 153
power switch assembly
removing 89
power-on password 146
printer problems 112
problems
audio 110
CD-ROM or DVD 123
flash drive 125
front panel 127
general 94
hard drive 100
hardware installation 116
Internet access 127
keyboard 114
Media Card Reader 103
memory 121
monitor 105
mouse 114
network 118
power 98
printer 112
processor 123
software 129
processor problems 123

R
rear components 5

rear cover
removing 62
recovery partition 142
removal and replacement
procedures
All-in One chassis 33
converter board 65
display cable 82
display panel 85
drive access panel 38
fan 63
front bezel 84
hard drive 42
hard drive connector 80
heat sink 54
heat sink cover 52
hinge cover panel 34
memory 45
memory access panel 36
optical drive 40
optical drive connector 80
power switch assembly 89
preparing to disassemble the
computer 33
rear cover 62
sidekey board 67
speakers 73
stand 61
stand bracket 75
system board 77
system board shield 69
thermal module 54
top panel 58
webcam module 59
WLAN module 71
removing battery 49
resetting
CMOS 146
password jumper 146
restoring the hard drive 142

S
safety and comfort 91
safety precautions
cleaning 30
SATA
connectors on system board
24
data cable pinouts 24
hard drive characteristics 24

screws, correct size 31
service considerations 31
setup password 146
side components 4
software

problems 129
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tool 31
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w
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Windows 8 operating system
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